Contents

1. Welcome to COPA-DATA help ........................................................................................................... 5

2. Controls .............................................................................................................................................. 5

3. General ................................................................................................................................................ 6
   3.1 Access zenon API ............................................................................................................................. 6
   3.2 Methods .......................................................................................................................................... 8
      3.2.1 CanUseVariables ......................................................................................................................... 8
      3.2.2 MaxVariables .............................................................................................................................. 9
      3.2.3 VariableTypes ............................................................................................................................ 9
      3.2.4 zenonExit .................................................................................................................................... 10
      3.2.5 zenonExitEd ............................................................................................................................... 10
      3.2.6 zenonInit ..................................................................................................................................... 10
      3.2.7 zenonInitEd ............................................................................................................................... 11

4. ActiveX ............................................................................................................................................. 11
   4.1 Develop ActiveX elements ............................................................................................................. 12
      4.1.1 Methods ..................................................................................................................................... 12
   4.2 Example LatchedSwitch (C++) ....................................................................................................... 15
      4.2.1 Interface ..................................................................................................................................... 15
      4.2.2 Control ...................................................................................................................................... 16
      4.2.3 Methods .................................................................................................................................... 19
      4.2.4 Operate and display .................................................................................................................. 21
      4.2.5 zenon Interface ......................................................................................................................... 24
   4.3 Example CD_SliderCtrl (C++) ....................................................................................................... 24
      4.3.1 Interface ..................................................................................................................................... 24
      4.3.2 Control ...................................................................................................................................... 25
      4.3.3 Methods .................................................................................................................................... 27
      4.3.4 Operate and display .................................................................................................................. 30
      4.3.5 zenon Interface ......................................................................................................................... 32
   4.4 Example :NET control as ActiveX (C#) ....................................................................................... 32
      4.4.1 Creat Windows Form Control .................................................................................................... 32
      4.4.2 Change .NET User Control to dual control ............................................................................ 36
4.4.3 Work via VBA with ActiveX in the Editor ................................................................. 41
4.4.4 Connect zenon variables with the .NET user control .................................................. 42

5. .NET user controls ........................................................................................................... 46
5.1 Different use .NET Control in Control Container or ActiveX ........................................... 47
5.2 Example .NET control container ..................................................................................... 47
  5.2.1 General ....................................................................................................................... 47
  5.2.2 Create .NET user control ......................................................................................... 50
  5.2.3 add a CD_DotNetControlContainer and a .NET User Control .............................. 59
  5.2.4 Accessing the user control via VSTA or VBA ......................................................... 64
5.3 Example .NET control as ActiveX (C#) ......................................................................... 68
  5.3.1 Creat Windows Form Control ................................................................................... 68
  5.3.2 Change .NET User Control to dual control ............................................................. 71
  5.3.3 Work via VBA with ActiveX in the Editor ............................................................... 76
  5.3.4 Connect zenon variables with the .NET user control ............................................. 77

6. WPF Element .................................................................................................................. 81
6.1 Basics ............................................................................................................................ 82
  6.1.1 WPF in process visualization .................................................................................. 82
  6.1.2 Transfer of values from zenon to WPF ................................................................. 84
  6.1.3 Referenced objects ................................................................................................. 85
  6.1.4 Allocation of zenon object to WPF content ........................................................... 86
  6.1.5 Workflows ............................................................................................................... 87
6.2 Manual for designer ....................................................................................................... 88
  6.2.1 Workflow with Microsoft Expression Blend ......................................................... 89
  6.2.2 Workflow with Adobe Illustrator .......................................................................... 93
6.3 Engineering in zenon ..................................................................................................... 101
  6.3.1 create WPF element .............................................................................................. 102
  6.3.2 CDWPF files (collective files) ................................................................................ 103
  6.3.3 Configuration of the linking .................................................................................... 104
  6.3.4 Validity of XAML Files ......................................................................................... 118
  6.3.5 Pre-built elements ................................................................................................. 120
  6.3.6 Examples: Integration of WPF in zenon ................................................................. 133
  6.3.7 Troubleshooting ..................................................................................................... 155
1. Welcome to COPA-DATA help

GENERAL HELP
If you cannot find any information you require in this help chapter or can think of anything that you would like added, please send an email to documentation@copadata.com (mailto:documentation@copadata.com).

PROJECT SUPPORT
You can receive support for any real project you may have from our Support Team, who you can contact via email at support@copadata.com (mailto:support@copadata.com).

LICENSES AND MODULES
If you find that you need other modules or licenses, our staff will be happy to help you. Email sales@copadata.com (mailto:sales@copadata.com).

2. Controls
In zenon you can integrate own controls. For this following is available:

- .NET user controls (on page 46) (For implementing in zenon see also .NET controls in manual Screens.)
- ActiveX (on page 11) (For implementing in zenon see also ActiveX in manual Screens.)
- WPF (on page 81)
Information

You can find information about how to use the zenon programming interfaces (PCE, VBA, VSTA) in manual Programming Interfaces.

License information

Part of the standard license of the Editor and Runtime.

Disconnector boxes

Attention

Note that errors in applications such as ActiveX, PCE, VBA, VSTA, WPF and external applications that access zenon via the API can also influence the stability of Runtime.

3. General

Controls for zenon can be implemented via ActiveX, .NET and WPF. Via VBA/VSTA you can access the zenon API.

3.1 Access zenon API

Under zenon you can enhance an ActiveX control with special functions in order to access the zenon API.

ACCESS THE ZENON API

- In Project References, select Add References... the zenon RT object library
- add the enhanced functions to the class code of the control

ENHANCED ZENON ACTIVEX FUNCTIONS

// Is called during the initializing of the control in the zenon Runtime.
public bool zenon.Init(zenon.Element dispElement)...
// Is called during the destruction of the control in the zenon Runtime.
public bool zenonExit()
// Supports the control variable linking
public short CanUseVariables()...
// Com control supports data types.
public short VariableTypes()...
// Maximum number of variables which can be linked to the control.
public short MaxVariables()...

**EXAMPLE**

The COM object of a zenon variable is temporarily saved in a Member in order to access it later in the Paint Event of the control.

zenon.

```
zenon.Variable m_cVal = null;

public bool zenon.Init(zenon.Element dispElement)
{
    if (dispElement.CountVariable > 0) {
        try {
            m_cVal = dispElement.ItemVariable(0);
            if (m_cVal != null) {
                object obRead = m_cVal.GetValue((object)-1);
                UserText = obRead.ToString();
            }
        } catch { }
    }
    return true;
}
```

```
public bool zenonExit()
{
    try {
        if (m_cVal != null) {
            System.Runtime.InteropServices.Marshal.FinalReleaseComObject(m_cVal);
            m_cVal = null;
        }
    } catch { }
    return true;
}
```
3.2 Methods

ActiveX and .NET controls which use zenon variables need certain methods.

3.2.1 CanUseVariables

Prototype: `short CanUseVariables();`

This method either returns 1 or 0.
<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:</td>
<td>The control can use zenon variables. For the dynamic element (via button <code>Variable</code>) you can only state zenon variables with the type stated via method <code>VariableTypes</code> (on page 9) in the number stated by method <code>MaxVariables</code> (on page 9).</td>
</tr>
<tr>
<td>0:</td>
<td>The control cannot use zenon variables or does not have the method. You can state variables with all types without restricting the number. In the Runtime however they only can be used with VBA.</td>
</tr>
</tbody>
</table>

### 3.2.2 MaxVariables

*Prototype:* `short MaxVariables();`

Here the number of variables is defined, that can be selected from the variable list.

If 1 is returned, multi-select is disabled in the variable list. A warning is displayed when several variables are selected anyway.

### 3.2.3 VariableTypes

*Prototype:* `short VariableTypes();`

The value returned by this method is used as a mask for the usable variable types in the variable list. The value is an `AND` relation from the following values (defined in `zenon32/dy_type.h`):
### 3.2.4 zenonExit

**Prototype:** `boolean zenonExit();`

This method is called by the zenon Runtime when the ActiveX control is closed. Here all dispatch pointers on variables should be released.

### 3.2.5 zenonExitEd

Equals `zenonExit` (on page 10) and is executed in closing the ActiveX in the Editor. Therewith you can also react to changes in the ActiveX e.g. values changes in Editor.

**Info:** Currently only available for ActiveX.

### 3.2.6 zenonInit

**Prototype:** `boolean zenonInit(IDispatch* dispElement);`
With this method (in the Runtime) the ActiveX control gets a pointer to the dispatch interface of the
dynamic element. With this pointer zenon variables linked to the dynamic element can be accessed.

You define the sorting order of the handed over variables in the configuration of the ActiveX element
with the help of buttons Down or Up.
The Element Input dialog appears after double-clicking the ActiveX element or after selecting property
ActiveX settings in the element properties in node Representation.

3.2.7  zenonInitEd

Equals zenonInit (on page 10) and is executed on opening the ActiveX (double click the ActiveX) in the
Editor.

Info: Currently only available for ActiveX.

4.  ActiveX

With ActiveX the functionality of the zenon Runtime and Editor can be enhanced autonomously.

In this manual you can find:

- Develop ActiveX elements (on page 12)
- Example LatchedSwitch (C++) (on page 15)
- Example CD_SliderCtrl (C++) (on page 24)
- Example :NET control as ActiveX (C#) (on page 32)

You can find information about the dynamic element ActiveX in manual Screens in chapter ActiveX.

ACTIVEX FOR WINDOWS CE

If an ActiveX Control should run under Windows CE, the apartment model must be set to Threading.
If it is set to Free, the control will not run in zenon Runtime.
4.1 Develop ActiveX elements

The dynamic element ActiveX in zenon can forward variables to the ActiveX control without using VBA to operate the control.

The control now defines by itself, how many zenon variables it can use and of what type they may be. Additionally the properties of the control can also be defined by the dynamic element.

For this the interface (dispatch interface) of the control must support a number of certain methods (on page 12).

4.1.1 Methods

Each ActiveX control which can use zenon variables must contain the following methods:

- CanUseVariables (on page 8)
- MaxVariables (on page 9)
- VariableTypes (on page 9)
- zeronExit (on page 10)
- zeronExitEd (on page 10)
- zeronInit (on page 10)
- zeronInitEd (on page 11)

It does not matter, which dispatch ID the methods have in the interface. On calling the methods zenon receives the correct ID from the interface.

CanUseVariables

Prototype: short CanUseVariables();

This method either returns 1 or 0.
<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1:    | The control can use zenon variables.  
      | For the dynamic element (via button `Variable`) you can only state zenon variables with the type stated via method `VariableTypes` (on page 9) in the number stated by method `MaxVariables` (on page 9). |
| 0:    | The control cannot use zenon variables or does not have the method.  
      | You can state variables with all types without restricting the number. In the Runtime however they only can be used with VBA. |

**MaxVariables**

Prototype: `short MaxVariables();`

Here the number of variables is defined, that can be selected from the variable list.

If 1 is returned, multi-select is disabled in the variable list. A warning is displayed when several variables are selected anyway.

**VariableTypes**

Prototype: `short VariableTypes();`

The value returned by this method is used as a mask for the usable variable types in the variable list. The value is an AND relation from the following values (defined in `zenon32/dy_type.h`):
### ActiveX

<table>
<thead>
<tr>
<th>Value 1</th>
<th>Value 2</th>
<th>Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>WORD</td>
<td>0x0001</td>
<td>Position 0</td>
</tr>
<tr>
<td>BYTE</td>
<td>0x0002</td>
<td>Position 1</td>
</tr>
<tr>
<td>BIT</td>
<td>0x0004</td>
<td>Position 2</td>
</tr>
<tr>
<td>DWORD</td>
<td>0x0008</td>
<td>Position 3</td>
</tr>
<tr>
<td>FLOAT</td>
<td>0x0010</td>
<td>Position 4</td>
</tr>
<tr>
<td>DFLOAT</td>
<td>0x0020</td>
<td>Position 5</td>
</tr>
<tr>
<td>STRING</td>
<td>0x0040</td>
<td>Position 6</td>
</tr>
<tr>
<td>IN_OUTPUT</td>
<td>0x8000</td>
<td>Position 15</td>
</tr>
</tbody>
</table>

#### zenonExit

Prototype: `boolean zenonExit();`

This method is called by the zenon Runtime when the ActiveX control is closed.

Here all dispatch pointers on variables should be released.

#### zenonExitEd

Equals `zenonExit` (on page 10) and is executed in closing the ActiveX in the Editor.

Therewith you can also react to changes in the ActiveX e.g. values changes in Editor.

**Info**: Currently only available for ActiveX.

#### zenonInit

Prototype: `boolean zenonInit(IDispatch*dispElement);`

With this method (in the Runtime) the ActiveX control gets a pointer to the dispatch interface of the dynamic element. With this pointer zenon variables linked to the dynamic element can be accessed.

You define the sorting order of the handed over variables in the configuration of the ActiveX element with the help of buttons `Down` or `Up`. 
The **Element Input** dialog appears after double-clicking the ActiveX element or after selecting property **ActiveX settings** in the element properties in node **Representation**.

### zenonInitEd

Equals zenonInit (on page 10) and is executed on opening the ActiveX (double click the ActiveX) in the Editor.

**Info:** Currently only available for ActiveX.

### 4.2 Example LatchedSwitch (C++)

The following example describes an ActiveX control, that realises a latched switch with two bit variables. The first variable represents the switch, the second variable the lock. The value of the switching variable of the ActiveX control can only be changed, if the locking variable has the value 0.

The status of the element is displayed with four bitmaps which can be selected in the properties dialog of the control in the zenon Editor.

#### 4.2.1 Interface

The control LatchedSwitch has the following dispatch interface:

```cpp
[ uuid(EB207159-D7C9-11D3-B019-080009FBEAA2),
 helpstring(Dispatch interface for LatchedSwitch Control), hidden ]
dispinterface _DLatchedSwitch
{
    properties:
    // NOTE - ClassWizard will maintain method information here.
    // Use extreme caution when editing this section.
    // ([AFX_ODL_PROP(CLatchedSwitchCtrl)
    [id(1)] boolean SollwertDirekt;
    [id(2)] IPictureDisp* SwitchOn; // container for the bitmaps
    [id(3)] IPictureDisp* SwitchOff;
    [id(4)] IPictureDisp* LatchedOn;
    [id(5)] IPictureDisp* LatchedOff;
    //})AFX_ODL_PROP
```
methods:
// NOTE - ClassWizard will maintain method information here.
// Use extreme caution when editing this section.
//{{AFX_ODL_METHOD(CLatchedSwitchCtrl)
//}}AFX_ODL_METHOD
[id(6)] short CanUseVariables();
[id(7)] short VariableTypes();
[id(8)] short MaxVariables();
[id(9)] boolean zenonInit(IDispatch* dispElement);
[id(10)] boolean zenonExit();
[id(DISPID_ABOUTBOX)] void AboutBox();
};

The properties SwitchOn to LatchedOff contain the bitmaps for displaying the four different states of the control. The bitmaps themselves are stored in objects of the class CScreenHolder. The property SollwertDirekt defines if the input of set values is done via a dialog or directly by clicking the control.

4.2.2 Control

Implementing the control is done with the class CLatchedSwitchCtrl. As members this class has the CScreenHolder objects for the storage of the bitmaps. Additionally three dispatch drivers for the dynamic element and the variables are generated:

class CLatchedSwitchCtrl : public COleControl
{

DECLARE_DYNCREATE(CLatchedSwitchCtrl)

// Constructor
public:

CLatchedSwitchCtrl();

// Overrides

// ClassWizard generated virtual function overrides
//{{AFX_VIRTUAL(CLatchedSwitchCtrl)
public:
virtual void OnDraw (CDC* pdc, const CRect& rcBounds, const CRect& rcInvalid);
virtual void DoPropExchange (CPropExchange* pPX);
}
virtual void OnResetState (){
virtual DWORD GetControlFlags();
//})AFX_VIRTUAL

// Implementation
protected:
~CLatchedSwitchCtrl();

DECLARE_OLECREATE_EX(CLatchedSwitchCtrl)    // Class factory and guid
DECLARE_OLETYPELIB(CLatchedSwitchCtrl)      // TypeInfo
DECLARE_PROPPAGEIDS(CLatchedSwitchCtrl)     // Property page IDs
DECLARE_OLECTLTYPE(CLatchedSwitchCtrl) // Type name and misc status

// Message maps

//{{AFX_MSG(CLatchedSwitchCtrl)
afx_msg void OnLButtonDown(UINT nFlags, CPoint point);
//}}AFX_MSG
DECLARE_MESSAGE_MAP()

// Dispatch maps

//{{AFX_DISPATCH(CLatchedSwitchCtrl)
BOOL m_sollwertDirekt;
afx_msg void OnSollwertDirektChanged();
afx_msg LPPICTUREDISP GetSwitchOn();
afx_msg void SetSwitchOn(LPPICTUREDISP newValue);
afx_msg LPPICTUREDISP GetSwitchOff();
afx_msg void SetSwitchOff(LPPICTUREDISP newValue);
afx_msg LPPICTUREDISP GetLatchedOn();
afx_msg void SetLatchedOn(LPPICTUREDISP newValue);
afx_msg LPPICTUREDISP GetLatchedOff();
afx_msg void SetLatchedOff(LPPICTUREDISP newValue);
afx_msg short CanUseVariables();
afx_msg short VariableTypes();
afx_msg short MaxVariables();
afx_msg BOOL zenonInit(LPDISPATCH dispElement);
afx_msg BOOL zenonExit();
/}AFX_DISPATCH
CScreenHolder m_SwitchOn;
CScreenHolder m_SwitchOff;
CScreenHolder m_LatchedOn;
CScreenHolder m_LatchedOff;

DECLARE_DISPATCH_MAP()

afx_msg void AboutBox();

// Event maps

//{{AFX_EVENT(CLatchedSwitchCtrl)
//}}AFX_EVENT
DECLARE_EVENT_MAP()

double VariantToDouble(const VARIANT FAR *v);
void VariantToCString(CString *c,const VARIANT FAR *v);
BOOL IsVariantString(const VARIANT FAR *v);
BOOL IsVariantValue(const VARIANT FAR *v);

// Dispatch and event IDs
public:

CString szVariable[2];
IElement m_dElement;
IVariable m_dLatchVar, m_dSwitchVar;

enum {
//}}AFX_DISP_ID(CLatchedSwitchCtrl)
dispidSollwertDirekt = 1L,
dispidSwitchOn = 2L,
dispidSwitchOff = 3L,
dispidLatchedOn = 4L,
dispidLatchedOff = 5L,
dispidCanUseVariables = 6L,
dispidVariableTypes = 7L,
dispidMaxVariables = 8L,
dispidZenOnInit = 9L,
dispidZenOnExit = 10L,
//}}AFX_DISP_ID
};
};

4.2.3 Methods

The following methods are used:

- CanUseVariables (on page 19)
- VariableTypes (on page 19)
- MaxVariables (on page 20)
- zenonInit (on page 20)
- zenonExit (on page 21)

CanUseVariables

This method returns 1, so zenon variables can be used.

short CLatchedSwitchCtrl::CanUseVariables()
{
    return 1;
}

VariableTypes

The control only can work with bit variables, so 0x0004 is returned.

short CLatchedSwitchCtrl::VariableTypes()
{
    return 0x0004;    // Only bit variables
MaxVariables

Two variables can be used. Therefore 2 is returned.

```cpp
short CLatchedSwitchCtrl::MaxVariables()
{
    return 2; // 2 variables
}
```

zenonInit

This method gets the dispatch drivers of the variables via the dispatch pointer of the dynamic element. With this pointer the variable values are read and written when clicking and drawing the control.

```cpp
BOOL CLatchedSwitchCtrl::zenonInit(LPDISPATCH dispElement)
{
    m_dElement = IElement(dispElement);

    if (m_dElement.GetCountVariable() >= 2)
    {

        short iIndex = 0;
        m_dSwitchVar =  IVariable(m_dElement.ItemVariable(COleVariant(iIndex)));
        m_dLatchVar =  IVariable(m_dElement.ItemVariable(COleVariant(++iIndex)));
    }
    return TRUE;
}
```
**zenonExit**

This method releases the dispatch driver.

```cpp
BOOL CLatchedSwitchCtrl::zenonExit()
{

    m_dElement.ReleaseDispatch();
    m_dSwitchVar.ReleaseDispatch();
    m_dLatchVar.ReleaseDispatch();
    return TRUE;
}
```

### 4.2.4 Operate and display

#### Setting values

A value can be set by clicking the control with the left mouse button.

If \texttt{m\_iSollwertDirekt} is 0, a dialog for the selection of the set value is opened, otherwise the current value of the switching variable is inverted.

If the locking variable has the value 1, only a \texttt{MessageBeep} is executed. No value can be set via the control.

```cpp
void CLatchedSwitchCtrl::OnLButtonDown(UINT nFlags, CPoint point)
{

    CRect rcBounds;
    GetWindowRect(&rcBounds);

    COleVariant coleValue((BYTE)TRUE);
    BOOL bLatch = (BOOL)VariantToDouble((LPVARIANT)&m_dLatchVar.GetValue());
    BOOL bSwitch = (BOOL)VariantToDouble((LPVARIANT)&m_dSwitchVar.GetValue());

    if (bLatch)   // Locked!!!
        MessageBeep(MB_ICONEXCLAMATION);
    else
```
{ 
if (m_sollwertDirekt) 
{ 
bSwitch = !bSwitch; 
} 
else 
{ 
CSollwertDlg dlg; 
dlg.m_iSollwert = bSwitch ? 1 : 0; 
if (dlg.DoModal() == IDOK) 
{ 
if (dlg.m_iSollwert == 2) // Toggle 
bSwitch = !bSwitch; 
else 
{ 
bSwitch = (BOOL)dlg.m_iSollwert; 
} 
}
coleValue = (double)bSwitch; 
m_dSwitchVar.SetValue(coleValue); 
} 
COleControl::OnLButtonDown(nFlags, point); }

**Drawing**

On drawing the control the values of the variables are read via their dispatch drivers, and accordingly one of the four defined graphics is displayed. When the value of a variable changes, the control is updated by the `OnDraw` routine.

```cpp
void CLatchedSwitchCtrl::OnDraw(CDC* pdc, const CRect& rcBounds, const CRect& rcInvalid) {
CRect rcBitmap = rcBounds;
```
rcBitmap.NormalizeRect();

if (!m_dElement)
{
  m_SwitchOn.Render(pdc, &rcBounds, &rcBounds);
  return;
}

BOOL bVal1 = 0, bVal2 = 0;
VARIANT vRes;
if (m_dSwitchVar)     // Variable exists?
{
  vRes = m_dSwitchVar.GetValue();
  bVal1 = (BOOL)VariantToDouble(&vRes);
}
if (m_dLatchVar)     // Variable exists?
{
  vRes = m_dLatchVar.GetValue();
  bVal1 = (BOOL)VariantToDouble(&vRes);
}
if (bVal1
  && bVal2)
  m_SwitchOn.Render(pdc, rcBitmap, rcBitmap);
else if (!bVal1
  && bVal2)
  m_SwitchOff.Render(pdc, rcBitmap, rcBitmap);
else if (bVal1
  && !bVal2)
  m_LatchedOn.Render(pdc, rcBitmap, rcBitmap);
else
  m_LatchedOff.Render(pdc, rcBitmap, rcBitmap);
4.2.5  zenon Interface

Classes deduced from COleDispatchDriver have to be created for the element and the variables, so that the dispatch interface of zenon can be used to set values. The easiest way to create these classes is the Class Wizard of the development environment (button Add Class, select From a type library, select zenrt32.tlb).

For our control theses are the classes IElement and IVariable. They are defined in zenrt32.h and zenrt32.cpp.

4.3  Example CD_SliderCtrl (C++)

The following example describes an ActiveX control which equals the Windows SliderCtrl. This component can be linked with a zenon variable. The user can change the value of a variable with this slider. If the value of the variable is changed with some other dynamic element, the slider is updated.

4.3.1  Interface

The control CD_SliderCtrl has the following dispatch interface:

```plaintext
[ uuid(5CD1B01D-015E-11D4-A1DF-080009FD837F),
  helpstring(Dispatch interface for CD_SliderCtrl Control), hidden
]
dispinterface _DCD_SliderCtrl
{
properties: //*** Properties of the controls

[id(1)] short TickRaster;
[id(2)] boolean ShowVertical;
[id(3)] short LineSize;

methods: //*** method of the control (for zenon ActiveX)

[id(4)] boolean zenonInit(IDispatch* pElementInterface);
[id(5)] boolean zenonExit();
[id(6)] short VariableTypes();
[id(7)] short CanUseVariables();
```
4.3.2 Control

Implementing the control is done with the class CD_SliderCtrlCtrl. This class has a standard Windows CSliderCtrl as a member, with which the control is subclassed. The interfaces IVariable and IElement contain zenon interfaces which had to be integrated. These are deduced from COleDispatchDriver.

class CCD_SliderCtrlCtrl : public COleControl
{

DECLARE_DYNCREATE(CCD_SliderCtrlCtrl)
private: //*** member variables

    BOOL m_bInitialized;
    BOOL m_bShowVertical;
    BOOL m_bTicksBoth;
    long m_nRangeStart;
    long m_nRangeEnd;
    long m_nTickOrientation;
    IVariable m_interfaceVariable;
    IElement m_interfaceElement;
    CSliderCtrl m_wndSliderCtrl;

public:

    CCD_SliderCtrlCtrl();

    //{{AFX_VIRTUAL(CCD_SliderCtrlCtrl)
    public:
    virtual void OnDraw (CDC* pdc, const CRect& rcBounds, const CRect& rcInvalid);
    virtual BOOL PreCreateWindow(CREATESTRUCT& cs);
    virtual void DoPropExchange (CPropExchange* pPX);
    virtual void OnResetState   ();

}{
protected:

~CCD_SliderCtrlCtrl();

//*** methods for the conversion from variant
double VariantToDouble(const VARIANT FAR *vValue);

DECLARE_OLECREATE_EX(CCD_SliderCtrlCtrl) // Class factory and guid
DECLARE_OLETYPELIB (CCD_SliderCtrlCtrl)    // TypeInfo
DECLARE_PROPPAGEIDS (CCD_SliderCtrlCtrl)    // Property page IDs
DECLARE_OLECTLTYPE (CCD_SliderCtrlCtrl)    // Type name and misc status

//*** methods for the functionality of the SliderCtrl
BOOL    IsSubclassedControl();
LRESULT OnOcmCommand       (WPARAM wParam, LPARAM lParam);

//{{AFX_MSG(CCD_SliderCtrlCtrl)
afx_msg int   OnCreate(LPCREATESTRUCT lpCreateStruct);
afx_msg void  HScroll(UINT nSBCode, UINT nPos);
afx_msg void  HScroll(UINT nSBCode, UINT nPos);
afx_msg void OnLButtonDown(UINT nFlags, CPoint point);
afx_msg void OnLButtonUp(UINT nFlags, CPoint point);
//}}AFX_MSG
DECLARE_MESSAGE_MAP()

//{{AFX_DISPATCH(CCD_SliderCtrlCtrl)
afx_msg BOOL GetTickOnBothSides();
afx_msg void SetTickOnBothSides (short nNewValue);
afx_msg BOOL GetShowVertical();
afx_msg void SetShowVertical (BOOL bNewValue);
afx_msg short GetTickOrientation();
afx_msg void SetTickOrientation (short nNewValue);
afx_msg BOOL zenonInit(LPDISPATCH pElementInterface);
afx_msg BOOL zenonExit();
//}}AFX_DISPATCH

//}}AFX_VIRTUAL
4.3.3 Methods

The following methods are used:

- CanUseVariables (on page 28)
- VariableTypes (on page 28)
- MaxVariables (on page 28)
- zenonInit (on page 29)
CanUseVariables

This method returns 1 so zenon variables can be used.

```cpp
short CCD_SliderCtrlCtrl::CanUseVariables()
{
    return 1;
}
```

VariableTypes

The control can work with word, byte, doubleword and float variables. You will find a list of the possible data types in the general description (on page 9) of this method.

```cpp
short CCD_SliderCtrlCtrl::VariableTypes()
{
    return 0x0001 | // Word
            0x0002 | // Byte
            0x0008 | // D-Word
            0x0010 | // Float
            0x0020; // D-Float
}
```

MaxVariables

Only one variable can be linked to this control.

```cpp
short CCD_SliderCtrlCtrl::MaxVariables()
{
    return 1; // 1 variables
}
```
**zenonInit**

The parameter `dispElement` contains the interface for the dynamic element. With this element the linked zenon variable determined. If it is valid, the area of the `SlideCtrl` is set. Additionally the settings for the display (number of ticks, ...) are set. If no variable is linked, the display range is set to 0 to 0. Thus the SliderCtrl cannot be changed. The variable `m_bInitialized` defines that values can be set from now on.

```cpp
BOOL CCD_SliderCtrlCtrl::zenonInit(LPDISPATCH dispElement)
{
    //*** Determine the variable using the zenon element
    m_interfaceElement = IElement(pElementInterface);
    if (m_interfaceElement.GetCountVariable() > 0) {
        short nIndex = 0;
        m_interfaceVariable = IVariable
            (m_interfaceElement.ItemVariable(COleVariant(nIndex)));
    }

    //*** Initialize the area of the Slider-Ctrl
    if (m_interfaceVariable) {
        //*** Define range
        m_nRangeStart = (long) VariantToDouble(&m_interfaceVariable.GetRangeMin());
        m_nRangeEnd = (long) VariantToDouble(&m_interfaceVariable.GetRangeMax());
        m_wndSliderCtrl.SetRange(m_nRangeStart, m_nRangeEnd, TRUE);
        //*** Define sub ticks
        m_wndSliderCtrl.SetTicFreq(m_nTickCount);
        m_wndSliderCtrl.SetPageSize(m_nTickCount);
        m_wndSliderCtrl.SetLineSize(m_nLineSize);
    } else {
        m_wndSliderCtrl.SetRange(0, 0, TRUE);
        return FALSE;
    }

    m_bInitialized = TRUE;
    return TRUE;
}
```
zenonExit

In this method the zenon interfaces are released again.

```cpp
BOOL CCD_SliderCtrlCtrl::zenonExit()
{
    m_interfaceElement.ReleaseDispatch();
    m_interfaceVariable.ReleaseDispatch();
    return TRUE;
}
```

### 4.3.4 Operate and display

**Drawing**

With DoSuperclassPaint the SliderCtrl is drawn (as is is a subclassed control). If at the moment of drawing the slider is moved, the variable `m_bInitialized` gets the value FALSE. This makes sure that the value can be changed. Normally the value of the variable is read and displayed with the method `SetPos` of the SliderCtrl.

```cpp
void CCD_SliderCtrlCtrl::OnDraw(CDC* pdc, const CRect& rcBounds, const CRect& rcInvalid)
{
    //*** update view
    DoSuperclassPaint(pdc, rcBounds);
    if (m_interfaceVariable && m_bInitialized) {
        COleVariant cValue(m_interfaceVariable.GetValue());
        int nValue = (int) VariantToDouble(&cValue.Detach());
        mWndSliderCtrl.SetPos(nValue);
    }
}
```
Setting values

In the method `LButtonDown` the variable `m_bInitialized` is set to `FALSE`, and in the event `LbuttonUp` it is set to `TRUE` again. This makes sure that the value can be changed. Otherwise the routine `OnDraw` would be executed and the old value would be displayed.

```cpp
void CCD_SliderCtrlCtrl::OnLButtonDown(UINT nFlags, CPoint point)
{
    m_bInitialized = FALSE;
    COleControl::OnLButtonDown(nFlags, point);
}

void CCD_SliderCtrlCtrl::OnLButtonUp(UINT nFlags, CPoint point)
{
    m_bInitialized = TRUE;
    COleControl::OnLButtonUp(nFlags, point);
}
```

A value is sent to the hardware, when the slider is moved. In the methods `HScroll` or `VScroll` the value is sent to the hardware (depending if it is a horizontal or a vertical slider).

```cpp
void CCD_SliderCtrlCtrl::HScroll(UINT nSBCode, UINT nPos)
{

    switch (nSBCode) {

    case TB_LINEUP:
    case TB_PAGEUP:
    case TB_LINEDOWN:
    case TB_PAGEDOWN:
    case TB_THUMBTRACK:
    case TB_THUMBPOSITION:{

        //*** Set value without dialog ?
        int nValue = m_wndSliderCtrl.GetPos();
        COleVariant cValue((short) nValue,VT_I2);
        m_interfaceVariable.SetValue(cValue);
    }
}
```
4.3.5  zenon Interface

Classes deduced from COleDispatchDriver have to be created for the element and the variables, so that the dispatch interface of zenon can be used to set values. The easiest way to create these classes is the Class Wizard of the development environment (button Add Class, select From a type library, select zenrt32.tlb).

For our control theses are the classes IElement and IVariable. They are defined in zenrt32.h and zenrt32.cpp.

4.4  Example :NET control as ActiveX (C#)

The following example describes a .NET control which is executed as ActiveX control in zenon.

The creation and integration is carried out in four steps:

1. Create Windows Form Control (on page 32)
2. Change .NET user control to dual control (on page 36)
3. Work via VBA with ActiveX in the Editor (on page 41)
4. Connect zenon variables with the .NET user control (on page 42)

4.4.1  Create Windows Form Control

To create a Windows Form Control:
1. Start Visual Studio 2008 and create a new Windows Form Control Library project:

2. Rename the default control to the desired control name.
   In our example: *SamplesControl.cs*. 

   ![Visual Studio Project Creation](image)

   ![Visual Studio Solution Explorer](image)
3. Open the Control Designer and add the desired control; in our case a text box:
4. Normally controls have properties. Open the Code Designer via View code and assign the desired properties which should be available externally.

In our example: Externally visible property "UserText" with get and set access which contains the text of the text box:

5. Compile the project.

The Windows Forms Control can now be used in other Windows Forms projects.
Important: The control must be inserted manually in the control tool box via Choose Items.

4.4.2 Change .NET User Control to dual control

To change the .NET in a dual control, you must first activate the COM interface for ActiveX.
1. Open the project and activate property `Register for COM interop` in the `Build settings`:

![Image of Build settings window]

2. Open the file `AssemblyInfo.cs` and
   - set attribute `ComVisible` to `true`
   - add attribute `ClassInterface` with
     
     ```
     [assembly: ComVisible(true)]
     ```
[assembly: ClassInterface(ClassInterfaceType.AutoDual)]
3. Open the code designer via **View Code** and add the necessary ActiveX attributes and **using** entries. Via menu **Tools/Create GUID** create a new GUID for the GUID attribute:

```
public SampleControl()
{
    InitializeComponent();
}
```

4. For the control to be selectable as Active X user interface control, you must add the functions to the following control classes:
   - RegisterClass
bullet UnregisterClass

After that you can register the control in the registry.

5. Compile the project again.

The Windows Form Control is now ActiveX-able and was registered automatically during the rebuild. An additional typelib file zenOnDotNetControl.tlb was created in the output directory.

6. To use the control on another computer:

a) copy the DLL file and the TLB file to the target computer

b) register the files via the command line:

```
%windir%\Microsoft.NET\Framework\v2.0.50727\regasm.exe zenOnDotNetControl.dll /tlb:zenOnDotNetControl.tlb
```
7. Add the extended Windows Form Control as ActiveX control to the zenon Editor:

4.4.3 Work via VBA with ActiveX in the Editor

To access the properties of the control in the zenon Editor:

1. In the zenon Editor in node Programming interfaces/VBA macros create a new Init macro with the name Init_ActiveX.

   In this macro you can access all external properties via obElem.ActiveX.
2. Assign his macro to the ActiveX control via properties VBA macros/Init of the ActiveX element.

EXAMPLE INIT MACRO

```
Public Sub Init_ActiveX(obElem As Element)
    obElem.AktiveX.Usertext = "Set the string to the control"
End Sub
```

4.4.4 Connect zenon variables with the .NET user control

In zenon you have the possibility to enhance an ActiveX control with special functions in order to access the zenon API.

NECESSARY METHODS

- public bool zenOnInit (on page 44) (Is called up during control initializing in the zenon Runtime.)
- public bool zenOnInitED (on page 45) (Is used in the Editor.)
- public bool zenOnExit() (on page 45) (Is called up during control destruction in the zenon Runtime.)
- public bool zenOnExitED() (on page 45) (Is used in the Editor.)
- public short CanUseVariables() (on page 45) (Supports linking variables.)
- public short VariableTypes() (on page 45) (Supported data types by the control)
- public MaxVariables() (on page 46)(Maximum number of variables which can be linked to the control.)

ADD REFERENCE

1. Select in Microsoft Visual Studio under Add References the zenon Runtime object library in order to be able to access the zenon API in the control.

2. Add the enhanced functions in the class code of the control in order to access the whole zenon API.
In our example the COM object of a zenon variable is temporarily saved in a Member in order to access it later in the Paint event of the control.

```csharp
public bool zenOnInit(zenOn.Element dispElement)
```

With this method (in the Runtime) the ActiveX control gets a pointer to the dispatch interface of the dynamic element. With this pointer zenon variables linked to the dynamic element can be accessed.

You can configure the sequence of the sent variables in the Enter Element dialog with the buttons down or up. The dialog "element input" opens if:

- you double click the ActiveX element or
- select Properties in the context menu or
- select the ActiveX settings property in the Representation node of the property window
public bool zenOnInitED(zenOn.Element dispElement)

Equals public bool zenOnInit (on page 44) and is executed when opening the ActiveX in the Editor (double click on ActiveX).

public bool zenOnExit()

This method is called by the zenon Runtime when the ActiveX control is closed. Here all dispatch pointers on variables should be released.

public bool zenOnExitED()

Equals public bool zenOnExit() (on page 45) and is executed in closing the ActiveX in the Editor. With this you can react to changes, e.g. value changes, in the Editor.

public short CanUseVariables()

This method returns 1 if the control can use zenon variables and 0 if it cannot.

- 1: For the dynamic element (via button Variable) you can only state zenon variables with the type stated via method VariableTypes in the number stated by method MaxVariables.
- 0: If CanUseVariables returns 0 or the control does not have this method, any number of variables of all types can be defined without limitations. In the Runtime however they only can be used with VBA.

public short VariableTypes()

The value returned by this method is used as a mask for the usable variable types in the variable list. The value is an AND relation from the following values (defined in zenon32/dy_type.h):
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WORD</td>
<td>0x0001</td>
<td>corresponds to position 0</td>
</tr>
<tr>
<td>BYTE</td>
<td>0x0002</td>
<td>corresponds to position 1</td>
</tr>
<tr>
<td>BIT</td>
<td>0x0004</td>
<td>corresponds to position 2</td>
</tr>
<tr>
<td>DWORD</td>
<td>0x0008</td>
<td>corresponds to position 3</td>
</tr>
<tr>
<td>FLOAT</td>
<td>0x0010</td>
<td>corresponds to position 4</td>
</tr>
<tr>
<td>DFLOAT</td>
<td>0x0020</td>
<td>corresponds to position 5</td>
</tr>
<tr>
<td>STRING</td>
<td>0x0040</td>
<td>corresponds to position 6</td>
</tr>
<tr>
<td>IN_OUTPUT</td>
<td>0x8000</td>
<td>corresponds to position 15</td>
</tr>
</tbody>
</table>

**public MaxVariables()**

Here the number of variables is defined, that can be selected from the variable list:

1: Multi-select is disabled in the variable list. A warning is displayed when several variables are selected anyway.

5. **.NET user controls**

With .NET control the functionality of the zenon Runtime and Editor can be enhanced autonomously.

In this manual you can find:

- Difference between control container and ActiveX (on page 47)
- Example .NET control container (on page 47)
- Example :NET control as ActiveX (C#) (on page 32)

You can find information about .NET controls in ActiveX in manual Screens in chapter .NET controls.
5.1 Different use .NET Control in Control Container or ActiveX

A .NET user control can:

- be integrated directly in the zenon ActiveX element via the CD_DotNetControlContainer control
- be used as ActiveX control and be integrated directly in the zenon ActiveX element

Above all the differences between container control and ActiveX control are:

<table>
<thead>
<tr>
<th>CD_DotNetControlContainer control</th>
<th>ActiveX control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Does not have to be registered at the computer.</td>
<td>Must be registered as Active X at the computer (regsvr32).</td>
</tr>
<tr>
<td>For changes at the controller only the DLL must be changed.</td>
<td>For changes at the controller the TLB must be registered again.</td>
</tr>
<tr>
<td>Access via VBA and VSTA only possible via the CD_DotNetControlContainer method.</td>
<td>Easy access via VBA and VSTA.</td>
</tr>
</tbody>
</table>

5.2 Example .NET control container

In this tutorial you get to know how to create a simple .NET user control in Visual Studio 2010 (programming language C#) and how to integrate it with the help of the zenon CD_DotNetControlContainer control as ActiveX in a zenon ActiveX element.

5.2.1 General

The CD_DotNetControlContainer therefore acts as a wrapper between the user control and the zenon ActiveX element. All methods used in the following example and all public methods and properties are passed on via the CD_DotNetControlContainer from the user control to the ActiveX and can be used by zenon; also in VBA and VSTA.
If there is a reference to the zenon programming interface in the user control, you can directly access zenon objects.

In the following example we will:

- create .NET user control (on page 50)
- add a CD_DotNetControlContainer and a .NET User Control (on page 59)
- enable the access to the user control via VSTA (VBA) (on page 64)

```csharp
public bool zenOnInit(zenOn.Element dispElement)
```

With this method (in the Runtime) the ActiveX control gets a pointer to the dispatch interface of the dynamic element. With this pointer zenon variables linked to the dynamic element can be accessed.

You can configure the sequence of the sent variables in the Enter Element dialog with the buttons down or up. The dialog "element input" opens if:

- you double click the ActiveX element or
- select Properties in the context menu or
- select the ActiveX settings property in the Representation node of the property window
public bool zenOnExit()

This method is called by the zenon Runtime when the ActiveX control is closed. Here all dispatch pointers on variables should be released.

public short CanUseVariables()

This method returns 1 if the control can use zenon variables and 0 if it cannot.

- 1: For the dynamic element (via button Variable) you can only state zenon variables with the type stated via method VariableTypes in the number stated by method MaxVariables.
- 0: If CanUseVariables returns 0 or the control does not have this method, any number of variables of all types can be defined without limitations. In the Runtime however they only can be used with VBA.

public short VariableTypes()

The value returned by this method is used as a mask for the usable variable types in the variable list. The value is an AND relation from the following values (defined in zenon32/dy_type.h):

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WORD</td>
<td>0x0001</td>
<td>corresponds to position 0</td>
</tr>
<tr>
<td>BYTE</td>
<td>0x0002</td>
<td>corresponds to position 1</td>
</tr>
<tr>
<td>BIT</td>
<td>0x0004</td>
<td>corresponds to position 2</td>
</tr>
<tr>
<td>DWORD</td>
<td>0x0008</td>
<td>corresponds to position 3</td>
</tr>
<tr>
<td>FLOAT</td>
<td>0x0010</td>
<td>corresponds to position 4</td>
</tr>
<tr>
<td>DFLOAT</td>
<td>0x0020</td>
<td>corresponds to position 5</td>
</tr>
<tr>
<td>STRING</td>
<td>0x0040</td>
<td>corresponds to position 6</td>
</tr>
<tr>
<td>IN_OUTPUT</td>
<td>0x8000</td>
<td>corresponds to position 15</td>
</tr>
</tbody>
</table>
public MaxVariables()

Here the number of variables is defined, that can be selected from the variable list:

1: Multi-select is disabled in the variable list. A warning is displayed when several variables are selected anyway.

5.2.2 Create .NET user control

The user control is a simple control which can set a new value via an input field (text box). After clicking the button, the value is written to the desired zenon variable.

An additional function should automatically detect the change of value of the variable in zenon and display the new value automatically in the control.

WORK STEPS

1. First you create a new project in VS and use project type „Windows Forms Control Library“

Important: Set framework to 3.5!
2. After that rename the CS file from "UserControl" to "zenon_CD_DotNetControlContainer.cs". The files Designer.cs and the .resx are renamed automatically.

3. In the next step you create the user control. For this use two text boxes one each for the input and the output and a button for writing new values to the zenon variable.
   Name:
   - the first text box "txtGetZenonVariable"
   - the second text box "txtSetZenonVariable"
   - the button "btnSetZenonVariable"

4. In order to access zenon objects you need a reference to the <CD_PRODUCNAME> Programming Interface. To do this:
   - click on node "References" in the Solution Explorer
   - open the context menu
   - select Add References...
   - switch to tab COM
   - select zenon programming interface library
After that the "zenOn" reference should be visible in the reference list.

5. In the next step create a global variable of type `zenon.variable` in the code of the `zenon_CD_DotNetControlContainer.cs`:

```csharp
using System;
using System.Collections.Generic;
using System.Diagnostics;
using System.Drawing;
using System.Windows.Forms;
using System.Xml;
using System.Xml.Linq;
using zenOn;

namespace zenon_CD_DotNetControlContainer
{
    public partial class zenon_CD_DotNetControlContainer : DotNetControl
    {
        // This will be needed to get the zenon variable container
        // zenon variable _x_vnl = null;

        public zenon_CD_DotNetControlContainer()
        {
            InitializeComponent();
        }
    }
}
```

6. This variable is initialized via public method `zenOnInit`:

```csharp
// summary
/// This public method will be called by the initialization of the control during
/// the zenon runtime.
///
/// <summary>
/// Private member.
///
/// <para>
/// public bool zenOnInit(zenon.Element displacement)
/// { 
///     if (zenon variables are added to the 
///     Control)
///     try
///     { 
///         // take the first zenon variable and added 
///         // to the global variable
///         _x_vnl = displacement.ItemValue(0);
///         // Get value to the Variable
///         txtTextvariable.Text = _x_vnl.GetValue().ToString();
///     } 
///     catch ()
///     { }
///     return true;
/// }
```}

and enabled via public method `zenOnExit`:

```csharp
// summary
/// This public Method will be called by the release of the control during
/// the zenon runtime.
///
/// <summary>
/// Private member.
///
/// <para>
/// public bool zenOnExit()
/// { 
///     if (_x_vnl != null)
///     { 
///         // Release the zenon variable (non delegate)
///         System.Runtime.InteropServices.Marshal.ReleaseComObject(_x_vnl);
///         _x_vnl = null;
///     }
///     return true;
/// }
```
In the following methods we define whether <CD_PROUDTCNAME> variables and data types are used and how many variables may be handed over:

7. In the next step define in the Click-Event of button btnSetZenonVariable that when you click the button the value of text box txtSetZenonVariable is written to the zenon variable and then the content of the text box is deleted.

8. To react to a value change of the variable, you need the Paint Event of the control. The Paint Event is also triggered if the value of the initialized zenon variable changes and it can therefore be used to update values. As variables which are referenced in the zenon ActiveX element are automatically advised, you can generally refrain from using the zenon.OnlineVariable container in the control.

THE CODE AT A GLANCE

Here is the whole code as review:
using System;
using System.Collections.Generic;
using System.ComponentModel;
using System.Drawing;
using System.Data;
using System.Linq;
using System.Text;
using System.Windows.Forms;
using zenOn;
namespace zenon_CD_DotNetControlContainer
{
    public partial class zenon_CD_DotNetControlContainer : UserControl
    {
        // This will be needed to get the zenon Variable Container
        zenOn.Variable m_cVal = null;
        public zenon_CD_DotNetControlContainer()
        {
            InitializeComponent();
        }
        /// <summary>
        /// This public Method will be called by the initialization of the control during
        /// the zenon Runtime.
        /// </summary>
        /// <param name="dispElement"> </param>
public bool zenOnInit(zenOn.Element dispElement)
{
    // Check if zenon Variables are added to the Control
    if (dispElement.CountVariable > 0)
    {
        try
        {
            // Take the first zenon Variable and added to the global Variable
            m_cVal = dispElement.ItemVariable(0);
        }
        catch()
        {
        }
        return true;
    }
}

public bool zenOnExit()
{
    try
    {
    }
    catch()
    {
    }
    return true;
}

/// <summary>
/// This public Method will be calles by the release of the control during the zenon Runtime.
/// </summary>
/// <returns></returns>
if (m_cVal != null)
{
    // Release the zenon Variable (Com-Object)
    System.Runtime.InteropServices.Marshal.FinalReleaseComObject(m_cVal);
    m_cVal = null;
}

try
{
}

catch{}

return true;

/// <summary>
/// This public Method is needed to link zenon Variables to the control.
/// </summary>
/// <returns></returns>
public short CanUseVariables()
{
    return 1; // Only this Variable is supported
}

/// <summary>
/// This public Method returns the Type of supported zenon Variables
/// </summary>
/// <returns></returns>
public short VariableTypes()
{
    return short.MaxValue; // all Data Types supported
}

/// <summary>
/// This public Method returns the number of
/// supported zenon Variables
/// </summary>
/// <returns></returns>
public short MaxVariables()
{
    return 1; // Only 1 Variable should linked to the Control
}

/// <summary>
/// This will be triggered by clicking the Button. The new Value will
/// be set to the zenon Variable
/// </summary>
/// <param name="sender"></param>
/// <param name="e"></param>
private void btnSetZenonVariable_Click(object sender, EventArgs e)
{
    //Set Value from TextBox to the zenon Variable
    m_cVal.set_Value(0,txtSetZenonVariable.Text.ToString());
    this.txtSetZenonVariable.Text = string.Empty;
}
/// <summary>
/// This will be triggered by painting the User Control or the Value of the Variable changed.
/// After the value of the Variable changed the Control will be new painted and the new Value will be set to the Textbox.
/// </summary>
/// <param name="sender"></param>
/// <param name="e"></param>

private void zenon_CD_DotNetControlContainer_Paint(object sender, PaintEventArgs e) {

    if (m_cVal != null) {
        this.txtGetZenonVariable.Text = m_cVal.get_Value(0).ToString();
        return;
    }

    else {
        this.txtGetZenonVariable.Text = "Variable Value";
        return;
    }
}
CREATE RELEASE

AT last create a Release in order to integrate the completed DLL in zenon or in the CD_DotNetControlContainer.

For this it is necessary that you switch from Debug to Release in the settings.

5.2.3 add a CD_DotNetControlContainer and a .NET User Control

To prepare the zenon project and to add the CD_DotNetControlContainer and the .NET User Control, carry out the following steps:

1. Create an internal variable of type String and set the string length to 30.
2. In the zenon project node Project/Files/Others add the DLL of the created .NET user controls.

   The DLL is located in the Visual Studio Project folder under bin\Release\zenon_CD_DotNetControlContainer.dll.

3. In the project select the ActiveX element and drag it in a zenon screen.
   - The dialog configuration is opened
   - Select the CD_DotNetControlContainer.Container control.

4. To embed the .NET user control in the CD_DotNetControlContainer control:
   - click on button Properties...
- a new dialog is opened

- click on button Load in order to select the path of the project folder, for example:
  C:\ProgramData\COPA-DATA\SQL\9888419d-251e-4595-b396-9be42367997c\FILES\zenon\custom\additional\zenon_CD_DotNetControlContainer.dll

By adding the DLL to folder additional, the control is automatically transferred when copying or loading the Runtime files to another computer. With this the link is lost.

Now the .NET user control should be displayed.
Confirm the dialog by clicking **OK**

5. In the last step link a variable with the control via button **Variables**.

The variable selected first is automatically linked with our globally defined variable (.NET UserControl) via **public** method **zenonInit**. The linking with the control is carried out after the Runtime start.
Then link the internal variable with a text element.

6. After the Runtime start the control is initially empty.

If you enter a value in the second text box and then confirm it with button Set zenon variable, the value is written to the zenon variable. (The btnSetZenonVariable_Click event is carried out.)

This is also displayed in the zenon text element.
If the value is directly changed in the zenon text element,

the value is directly written in the first text box via the `Paint` event of the .NET control.

5.2.4 Accessing the user control via VSTA or VBA

This examples shows the access via VSTA. The procedure is the same as with VBA.

1. Enhance the control with a label (label) and name it `lblZenonInfo`. In this label the value of another zenon variable should be displayed. The new value should be set via a VSTA macro.
2. Enhance the code by a property (Information) and add the properties get and set to the property. They allow you to read and write the text of the label.

```csharp
public partial class zenon_CD.DotNetControlContainer : UserControl

{ //this will be needed to get the zenon Variable container

    zenon_variable my_var = null;

    public zenon_CD.DotNetControlContainer()
    { InitializeComponent(); }

    public string Information
    { 
        set { this.ESilhouetteInfo.Text = value; } 
        get { return this.ESilhouetteInfo.Text; } 
    }

}
```

3. Create a new release for our user control and copy it to folder additional of the zenon project.

   **Do not forget**: Close the zenon Editor before you do this!

   Delete the old DLL and restart the zenon Editor. If the DLL is still in the folder, just delete it a second time. Now you can import the changed DLL. The CD_DotNetContainerControl and the ActiveX are updated automatically.

4. In the zenon Editor click on the ActiveX and open the property window.
Now you can see the new property **Information** in the selection window of the control and you can also set a value.

![Image of control selection window with the Information property set and the value set in the control](image1.png)

This value is also set in the control ("myInformation")

![Image of control with the myInformation property set](image2.png)

5. In order to able to work with the **CD_DotNetControlContainer** in VSTA or VBA, you first need the reference to the control. After VSTA has been opened for the project (**ProjectAddin**), you must add the reference of the **CD_DotNetControlContainer**.
In addition you must also add the Assembly `System.Windows.Forms`.

6. With the following code you can set the value of our property `Information` anew.

```csharp
public void Macro_Text()
{
    try
    {
        string element = this.DotNetControl1.Text;
        string text = this.DotNetControl1.Text;
        // Create a variable of type CD_DotNetControlContainer.Text and set the zenon Element
        CD_DotNetControlContainer text = (CD_DotNetControlContainer)element.AttachedObject;
        // Get the name of the Property "Information" we can set
        // in the new Value "New Information" to the Property
    }
    catch (Exception ex)
    {
    }
}
```

7. Finally:
   - create a new zenon function `Execute VSTA macro`
   - link the function to a button

In the Runtime the label is changed from `myInformation` to `New Information` by clicking on the button.

And back when you click the button again.
5.3 **Example :.NET control as ActiveX (C#)**

The following example describes a .NET control which is executed as ActiveX control in zenon.

The creation and integration is carried out in four steps:

1. **Create Windows Form Control** (on page 32)
2. **Change .NET user control to dual control** (on page 36)
3. **Work via VBA with ActiveX in the Editor** (on page 41)
4. **Connect zenon variables with the .NET user control** (on page 42)

5.3.1 **Create Windows Form Control**

To create a Windows Form Control:

1. **Start Visual Studio 2008 and create a new Windows Form Control Library project:**

![Visual Studio Project Creation](image)
2. Rename the default control to the desired control name.
   In our example: `SampleControl.cs`.

3. Open the Control Designer and add the desired control; in our case a text box:
4. Normally controls have properties. Open the Code Designer via View code and assign the desired properties which should be available externally.
   In our example: Externally visible property "UserText" with `get` and `set` access which contains the text of the text box:

5. Compile the project.

The Windows Forms Control can now be used in other Windows Forms projects.
Important: The control must be inserted manually in the control tool box via Choose Items.

5.3.2 Change .NET User Control to dual control

To change the .NET in a dual control, you must first activate the COM interface for ActiveX.
1. Open the project and activate property **Register for COM interop** in the Build settings:

![Image of Build settings](image)

2. Open the file `AssemblyInfo.cs` and
   - set attribute `ComVisible` to `true`
   - add attribute `ClassInterface` 

```csharp
[assembly: ComVisible(true)]
```
[assembly: ClassInterface(ClassInterfaceType.AutoDual)]
3. Open the code designer via View Code and add the necessary ActiveX attributes and using entries. Via menu Tools/Create GUID create a new GUID for the GUID attribute:

![Code designer screenshot]

4. For the control to be selectable as Active X user interface control, you must add the functions to the following control classes:
   - RegisterClass
• **UnregisterClass**

After that you can register the control in the registry.

5. **Compile the project again.**

The Windows Form Control is now ActiveX-able and was registered automatically during the rebuild. An additional typelib file `zenOnDotNetControl.tlb` was created in the output directory.

6. **To use the control on another computer:**

   a) copy the DLL file and the TLB file to the target computer

   b) register the files via the command line:

   ```
   %windir%\Microsoft.NET\Framework\v2.0.50727\regasm.exe zenOnDotNetControl.dll /tlb:zenOnDotNetControl.tlb
   ```
7. Add the extended Windows Form Control as ActiveX control to the zenon Editor:

5.3.3 Work via VBA with ActiveX in the Editor

To access the properties of the control in the zenon Editor:

1. In the zenon Editor in node Programming interfaces/VBA macros create a new Init macro with the name Init_ActiveX.

   In this macro you can access all external properties via obElem.ActiveX.
2. Assign his macro to the ActiveX control via properties VBA macros/Init of the ActiveX element.

![Image of ActiveX control setup in Zenon]

**EXAMPLE INIT MACRO**

```vba
Public Sub Init_ActiveX(obElem As Element)
    obElem.AktiveX.Usertext = "Set the string to the control"
End Sub
```

### 5.3.4 Connect zenon variables with the .NET user control

In zenon you have the possibility to enhance an ActiveX control with special functions in order to access the zenon API.

**NECESSARY METHODS**

- `public bool zenOnInit` (on page 44) (Is called up during control initializing in the zenon Runtime.)
- `public bool zenOnInitED` (on page 45) (Is used in the Editor.)
- public bool zenOnExit() (on page 45) (Is called up during control destruction in the zenon Runtime.)
- public bool zenOnExitED() (on page 45) (Is used in the Editor.)
- public short CanUseVariables() (on page 45) (Supports linking variables.)
- public short VariableTypes() (on page 45) (Supported data types by the control)
- public MaxVariables() (on page 46) (Maximum number of variables which can be linked to the control.)

**ADD REFERENCE**

1. Select in Microsoft Visual Studio under *Add References* the zenon Runtime object library in order to be able to access the zenon API in the control.

2. Add the enhanced functions in the class code of the control in order to access the whole zenon API.
In our example the COM object of a zenon variable is temporarily saved in a Member in order to access it later in the Paint event of the control.

```csharp
public bool zenOnInit(zenOn.Element dispElement)
```

With this method (in the Runtime) the ActiveX control gets a pointer to the dispatch interface of the dynamic element. With this pointer zenon variables linked to the dynamic element can be accessed.

You can configure the sequence of the sent variables in the Enter Element dialog with the buttons down or up. The dialog "element input" opens if:

- you double click the ActiveX element or
- select properties in the context menu or
- select the ActiveX settings property in the Representation node of the property window
public bool zenOnInitED(zenOn.Element dispElement)

Equals public bool zenOnInit (on page 44) and is executed when opening the ActiveX in the Editor (double click on ActiveX).

public bool zenOnExit()

This method is called by the zenon Runtime when the ActiveX control is closed. Here all dispatch pointers on variables should be released.

public bool zenOnExitED()

Equals public bool zenOnExit() (on page 45) and is executed in closing the ActiveX in the Editor. With this you can react to changes, e.g. value changes, in the Editor.

public short CanUseVariables()

This method returns 1 if the control can use zenon variables and 0 if it cannot.

- 1: For the dynamic element (via button Variable) you can only state zenon variables with the type stated via method VariableTypes in the number stated by method MaxVariables.
- 0: If CanUseVariables returns 0 or the control does not have this method, any number of variables of all types can be defined without limitations. In the Runtime however they only can be used with VBA.

public short VariableTypes()

The value returned by this method is used as a mask for the usable variable types in the variable list. The value is an AND relation from the following values (defined in zenon32/dy_type.h):
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WORD</td>
<td>0x0001</td>
<td>corresponds to position 0</td>
</tr>
<tr>
<td>BYTE</td>
<td>0x0002</td>
<td>corresponds to position 1</td>
</tr>
<tr>
<td>BIT</td>
<td>0x0004</td>
<td>corresponds to position 2</td>
</tr>
<tr>
<td>DWORD</td>
<td>0x0008</td>
<td>corresponds to position 3</td>
</tr>
<tr>
<td>FLOAT</td>
<td>0x0010</td>
<td>corresponds to position 4</td>
</tr>
<tr>
<td>DFLOAT</td>
<td>0x0020</td>
<td>corresponds to position 5</td>
</tr>
<tr>
<td>STRING</td>
<td>0x0040</td>
<td>corresponds to position 6</td>
</tr>
<tr>
<td>IN_OUTPUT</td>
<td>0x8000</td>
<td>corresponds to position 15</td>
</tr>
</tbody>
</table>

**public MaxVariables()**

Here the number of variables is defined, that can be selected from the variable list:

1: Multi-select is disabled in the variable list. A warning is displayed when several variables are selected anyway.

6. **WPF Element**

With the WPF dynamic element, valid WPF/XAML files in zenon can be integrated and displayed.

---

**Information**

All brand and product names in this documentation are trademarks or registered trademarks of the respective title holder.
6.1 Basics

XAML

XAML stands for Extensible Application Markup Language. The description language developed by Microsoft and based on XML defines the syntax in Silverlight applications and WPF user interfaces. XAML makes it possible to separate design and programming. The designer prepares the graphical user interface and creates basic animations that are then used by the developers/project planners. The project planner can control these .xaml files in a purposeful manner and animate them accordingly.

WPF

WPF stands for Windows Presentation Foundation and describes a graphics framework that is part of the Windows .NET framework:

- WPF displays the programming environment.
- XAML describes, based on XML, the interface hierarchy as a markup language. Depending on the construction of the XAML file, there is the possibility to link properties, events and transformations of WPF elements with variables and functions of CD_PRODUCTNAME<.
- The framework unites the different areas of presentation such as user interface, drawing, graphics, audio, video, documents and typography.

WPF is, according to Microsoft, supplied with Windows 8, Windows 7, Windows Vista and Windows Server 2008. Microsoft .NET 3.5 is required for execution.

6.1.1 WPF in process visualization

XAML makes different design possibilities possible for zenon. Display elements and dynamic elements can be adapted graphically regardless of the project planning. For example, laborious illustrations are first created by designers and then imported into zenon as an XAML file and linked to the desired logic. There are many possibilities for using this, for example:
DYNAMIC ELEMENTS IN ANALOG-LOOK

Graphics no longer need to be drawn in zenon, but can be imported directly as an XAML file. This makes it possible to use complex, elaborately illustrated elements in process visualization. Reflections, shading, 3D effects etc. are supported as graphics. The elements that are adapted to the respective industry environment make intuitive operation possible, along the lines of the operating elements of the machine.

INTRICATE ILLUSTRATIONS FOR INTUITIVE OPERATION

The integration of XAML-based display elements improves the graphics of projects and makes it very easy to display processes clearly. Elements optimized for usability make operation easier. A clear display of data makes it easier to receive complex content. The flexible options for adapting individual elements makes it easier to use for the operator. It is therefore possible for the project planners to determine display values, scales and units on their own.

CLEAR PRESENTATION OF DATA AND SUMMARIES

Grouped display elements make it possible to clearly display the most important process data, so that the equipment operator is always informed of the current process workflow. Graphical evaluations, display values and sliders can be grouped into an element and make quick and uncomplicated control possible.

INDUSTRY-SPECIFIC DISPLAYS
Elements such as thermometers, scales or bar graphs are part of the basic elements of process visualization. It is possible, using XAML, to adapt these to the respective industry. Thus equipment operators can find the established and usual elements that they already know from the machines in process visualization at the terminal.

ADAPTATION TO CORPORATE DESIGN

Illustrations can be adapted to the respective style requirements of the company, in order to achieve a consistent appearance through to the individual process screen. For example, the standard operation elements from zenon can be used, which can then be adapted to color worlds, house fonts and illustration styles of the corporate design.

6.1.2 Transfer of values from zenon to WPF

zenon always works internally with the double or string. These are sent to the WPF element. The WPF element is embedded in a .NET container. It usually needs to be converted so that the data type can be used. This conversion can automatically be carried out by .NET.

The values are sent in accordance with the following rules:

- If the .NET type (System.Object) for zenon is not evident, the value is sent as it is to .NET. .NET must take care of the display or conversion itself.
- If the .NET type is a Boolean type (System.Boolean), then zenon writes according to the .NET convention 0 or -1.
- If the .NET type is known, a check is carried out to see if .NET can convert the value. The converter from .NET is used for this.
  - Yes: The value is sent.
  - No: The value is sent nevertheless. If .NET reacts with an error message, the value of zenon is converted into a string and sent again.
### 6.1.3 Referenced objects

In WPF not only standard objects such as rectangles, buttons, text fields, etc. can be used, but also WPF user controls, which are referenced as assemblies.

WPF user controls are individually created objects. For example, this element can look like a tacho and provide special properties and optical effects, such as a "Value" property, which causes the pointer of the tacho to move and display the value when it is set.

The workflow for this:

- The appearance of a user controls is labeled with standard objects, which are offered by WPF.
- The properties and interactions are programmed.
- The whole package is compiled and present in the form of a .NET assembly.

This assembly can also be used for WPF projects. To do this, it must be referenced (linked) in the WPF editor (for example: Microsoft Expression Blend). To do this, select the assembly in the zenon file selection dialog:

![Zenon file selection dialog](image)

From this point in time, the WPF user controls of the assembly in the tool box can be selected under Custom user controls and used in the WPF project.

### USED REFERENCED ASSEMBLIES IN ZENON

To use an assembly in zenon, this must be provided as a file. Collective files in .cdwpf format administer these independently; no further configuration is necessary. Assemblies must be added to the Files folder for .xaml files:

- Click on Files on the project tree
- Select Other
- Select Add file... in the context menu
- The configuration dialog opens
- Insert the desired assembly
When displaying a WPF file in the **WPF element** (Editor and Runtime), the assemblies from this folder are loaded. It is thus also ensured that that when the Runtime files are transferred using **Remote Transport**, all referenced assemblies are present on the target computer.

A collective file (.cdwpf) can exist alongside an XAML file with the same name. All assemblies (*.dll) from all collective files and the **Other** folder are copied to the work folder. Only the highest file version is used if there are several assemblies with the same name.

---

**Attention**

Assemblies are only only removed after loading when the application is ended. That means:

*If a WPF file with a referenced assembly in zenon is displayed, then this assembly is loaded is in the memory until zenon is ended, even if the screen is closed again. If you would like to remove an assembly from the Files/Other folder, the Editor must first be restarted, so that the assembly is removed.*

---

**MULTI-PROJECT ADMINISTRATION**

With multi-project administration, the same assembly must be used in all projects. If an assembly is replaced by another version in a project, it must also be replaced in all other projects that are loaded in the Editor or in Runtime.

---

### 6.1.4 Allocation of zenon object to WPF content

zenon objects are allocated to WPF content using the name of the WPF object. In doing so, note:

Visual objects do not have a `RuntimeNamePropertyAttribute` property. Therefore at the time when the WPF content is loaded and created, the additional information of name is not available.

Thus a clear allocation of zenon objects to WPF objects is not possible. Therefore only logical objects are listed in the configuration dialog of zenon. Which WPF objects the `RuntimeNamePropertyAttribute` has available is visible in MSDN or on the Microsoft website.

---

**WORKAROUND**

Nevertheless, the following workaround is possible to animate visual objects:
For visual elements, the animateable property is linked to the text property of an invisible text box using a data connection.

**Because the text box as a logical object supports the `name` property, this is displayed in zenon.**

The textbox property can also be animated with zenon.

This visual object is also indirectly animated as a result.

### 6.1.5 Workflows

The WPF/XAML technology makes new workflows in process visualization possible. The separation of design and functionality ensures a clear distinction of roles between the project planners and designers; design tasks can be easily fulfilled by using pre-existing designs, which no longer need to be modified by the project planner.

The following people are involved in the workflow to create WPF elements in zenon:

- **Designer**
  - illustrates elements
  - takes care of the graphics for MS Expression Design

- **MS Expression Blend operator**
  - Animates elements
  - Creates variables for the animation of WPF elements in zenon, which project planners can access

- **Project planner**
  - Integrates elements into zenon:
  - stores logic and functionality

We make a distinction:

- **Workflow with Microsoft Expression Blend** (on page 88)
- **Workflow with Adobe Illustrator** (on page 88)
Workflow with Microsoft Expression Blend

When using Microsoft Expression Blend, a WPF element is created in four stages:

1. Illustration of elements in **MS Expression Blend** (on page 89)
2. Open element in **MS Expression Design** and export as WPF
3. Animation in **MS Expression Blend** (on page 89)
4. Integration into zenon (on page 134)

You can find an example for creating a WPF elements with Microsoft Expression Blend in the Create button as XAML file with Microsoft Expression Blend (on page 89) chapter.

Workflow with Adobe Illustrator

Based on traditional design processes with **Adobe Illustrator** the following workflow is available:

1. Illustration of elements in **Adobe Illustrator** (on page 94)
2. Import of `.ai` files and preparation in **MS Expression Design** (on page 96)
3. WPF export from **MS Expression Design** (on page 96)
4. Animation in **MS Expression Blend** (on page 98)
5. Integration into zenon (on page 141)

You can find an example for creation in the Workflow with Adobe Illustrator (on page 93) chapter.

6.2 Manual for designer

This section informs you how to correctly create WPF files in Microsoft Expression Blend and Adobe Illustrator. The tutorials on Creating a button element (on page 89) and a bar graph element (on page 93) show you how fully functional WPF files for zenon can be created from pre-existing graphics in a few steps.

The following tools were used for this:

- Adobe Illustrator CS3 (AI)
- Microsoft Expression Design 4 (ED)
6.2.1 Workflow with Microsoft Expression Blend

With Microsoft Expression Blend, a WPF element:

- is illustrated
- is converted into WPF format using MS Expression Design
- animated

The following example shows the illustration and conversion of a button element into an XAML file.

**Note:** A test version of "Microsoft Expression Blend" can be downloaded from the Microsoft website.

Create button as an XAML file with Microsoft Expression Blend

**CREATE BUTTON**

1. Start Expression Blend
2. select the **New Project** option

3. Select **WPF** as project type

4. give it a path and name of your choice (MyBlendProject, for example)

The **Language** and **version** settings can be ignored, because no functionality is to be programmed.
5. After the dialog has been confirmed with OK, Microsoft Blend creates a new project with the chosen settings. Expression Blend adds an empty XAML file which already contains a class reference.

6. Delete the CS file that belongs to the XAML file using the context menu.

7. Rename the XAML file `MainControl.xaml` to `MyButton.xaml`.

8. The development size of the file is set at 640 x 480 pixels as standard and must still be changed:
   a) switch to XAML view
   b) correct the size to 100 x 100 pixels
   c) Delete the class reference `x:Class="MyBlendProject.MyButton"`

9. switch to Design view

10. add a button via the tool bar

11. define the properties
   - Width: 50
   - Height: 50
• Margins: 25

The button is therefore at the center of the control.

12. Save the changes and open the file in Internet Explorer to check it. You will see that the button is displayed in a size of 50 x 50 pixels.

MAKE BUTTON SCALABLE

If you integrate this status into zenon, the button will always have the exact size of 50 x 50 pixels. Because the button can be implemented as a scalable button, switch to Expression Blend again:

1. select the button in the tree view
2. select the Group Into->Viewbox button in the context menu
3. the button is inserted into a Viewbox
4. Define the properties of the viewbox
   • Width: Auto
   • Height: Auto
5. save the file

6. If you now open the file in Internet Explorer, the button is automatically scaled when the IE window size is changed. This file will now also automatically adapt to changes in the size of the WPF element in zenon.

CHANGE NAME

Before you can integrate the file into zenon, you must give the WPF element a name. The WPF elements are not named in Expression Blend as standard, and are labeled with square brackets and their type. zenon content is assigned to WPF content via the name of the WPF elements:

- in tree view, change the name
  - of the button on MyButton
  - of the VBoxBox to MyViewBox

This button can now be integrated in zenon (on page 134) as an XAML file.

6.2.2 Workflow with Adobe Illustrator

When Adobe Illustrator is used, a WPF element:

- is illustrated in Adobe Illustrator
- is converted into a WPF in MS Expression Design
- is animated in MS Expression Blend
The following example shows the illustration and conversion of a bar graph element into an XAML file.

Bar graph illustration

A bar graph is created in Adobe Illustrator.

1. **AI: Starting element for bar graph**

   Illustrated in Adobe Illustrator CS3.

2. **AI: Path view of bar graph in Adobe Illustrator**

   - All effects must be converted (Object -> Convert appearance)
   - All lines are transformed into paths (Object -> Path -> Contour line)
   - Do not use filters such as shading, blurring etc.

**NOTES ON COMPATIBILITY**

Illustrations that were created with Adobe Illustrator are in principle suitable for WPF export. However, not all Illustrator effects can become corresponding effects in Expression Design/Blend. Note:
<table>
<thead>
<tr>
<th>Effect</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipping masks</td>
<td>Clipping masks created in Adobe Illustrator are not correctly interpreted by Expression Design. These are usually shown in Blend as areas of black color. We recommend creating illustrations without clipping masks.</td>
</tr>
</tbody>
</table>
| Filters and effects                  | Not all Adobe Illustrator filters are transferred into Expression Design accordingly: Thus blurring filters, shading filters and corner effects from Illustrator do not work in Expression Design. Solution:  
  - Most effects can be converted so that they can be read correctly by Expression Design using the **Object -> Convert appearance** command in Adobe Illustrator.  
  - Corner effects from Adobe Illustrator are correctly interpreted by MS Design if they are converted to AI in paths. |
| Text fields                          | To be able to link text fields with code, these must be created separately in Expression Blend. "**Labels**" are required for dynamic texts; simple "**text fields**" are sufficient for static information. There is no possibility to create text labels in MS Design. These must be directly created in MS Blend. |
| Transparencies and group transparencies | There can be difficulties in Adobe Illustrator with the correct interpretation of transparency settings, in particular from group transparency settings. However MS Expression Blend and MS Expression Design do offer the possibility to create new transparency settings. |
| Multiply levels                      | These level settings in Adobe Illustrator are not always correctly displayed by MS Expression Blend. However, there is the possibility to "**Multiply levels**" directly in Expression Design. |
| Indicating instruments and standard positions | To prepare the graphics optimally for animation, the indicator and slider must always be set to the starting position, usually **0** or **12:00 o'clock**. Thus the position parameters for rotations etc. are also correct in Blend and an animation can be implemented without conversion of position data. |
**WPF export**

WPF files are required for animation in Microsoft Expression Blend. We recommend Microsoft Expression Design for this export, because it provides good results and most Illustrator effects are correctly interpreted.

**Note:** There is a free plug-in for the direct export of WPF files from Adobe Illustrator available on the internet. This plug-in provides a quick, uncomplicated way of exporting from Illustrator, however it is less suited to the current application because it lead to graphical losses. Even color deviations from the original document are possible.

Files in .ai format can regularly be imported into Expression Design; the paths are retained in the process. **Attention:** Some common Illustrator effects cannot be displayed by Expression Design correctly however (see Illustration (on page 94) chapter).

We export the pre-created bar graph element in 5 stages:

1. **ED: Import**
   - Import the prepared Illustrator file (on page 94) in *Microsoft Expression Design* via *File -> Import*

2. **ED: Optimization**
- If the starting file is not correctly displayed in MS Expression Design, it can still be subsequently edited and optimized here

3. **ED: Selection**

   - Highlight the element for WPF export with the direct selection arrow in MS Expression Design; in this case it is the whole clock

4. **ED: Start export**

   - Start the export via **File -> Export**
   - The dialog for configuring the export settings opens

5. **ED: Export settings**

   - **Enter the following export settings:**
     a) **Format**: XAML Silverlight 4 / WPF Canvas
        Always name objects: **Activate with tick**
        Place the grouped object in an XAML layout container: **Activate with tick**
     b) **Text**: Editable text block
     c) **Line effects**: Rasterize all

   The exported file has `.xaml` file suffix. It is prepared and animated (on page 98) in MS Expression Blend in the next stage.
Animation in Blend

With MS Expression Blend:

- static XAML files from MS Expression Design are animated
- Variables for controlling effects that can be addressed by zenon are created

In thirteen steps, we go from a static XAML to an animated element, that can be embedded in zenon:

1. **EB: create project**
   
   a) Open Microsoft Expression Blend  
   b) Create a new project  
   c) Select the Project type of *WPF* -> *WPF Control Library*  
   d) Give it a name (in our tutorial: *My_Project*)  
   e) Select a location where it is to be saved  
   f) Select a language (in our tutorial: C#)  
   g) Select Framework Version 3.5

2. **EB: delete MainControl.xaml.cs**
   
   a) Navigate to *MainControl.xaml.cs*  
   b) Delete this file using the Delete command in the context menu

3. **EB: Open exported XAML file**
   
   a) Open the context menu for *My_Project* (right mouse button)  
   b) Select Add existing element...  
   c) Select the XAML file exported from Microsoft Expression Design, in order to open this in Microsoft Expression Blend
4. EB: Open MainControl.xaml

a) Open the automatically created MainControl.xaml

b) In the Objects and Time axes area, navigate to the UserControl entry

5. EB: Adapt XAML code

a) Click on UserControl with the right mouse button

b) Select display XAML in the contextual menu.

c) Delete lines 7 and 9 in the XAML code:

```
x:Class="My_Project.MainControl"
d:DesignWidth="640" d:DesignHeight="480"
```

6. EB: check XAML code

- The XAML code should now look like this:

```
<UserControl
    xmlns=http://schemas.microsoft.com/winfx/2006/xaml/presentation
    xmlns:x=http://schemas.microsoft.com/winfx/2006/xaml

    mc:Ignorable="d"
    x:Name="UserControl">
```
7. **EB: Copy elements**

   a) Open the XAML file imported from Expression Design
   b) Mark all elements
   c) Select **Delete** in the context menu
   d) Change back to the automatically created XAML file

8. **EB: Insert element**

   a) Click on **Layout Root** with the right mouse button
   b) Select **Insert**

9. **EB: Adapt layout type**

   a) Click on **Layout root** -> **Change layout type** -> **Viewbox** with the right mouse button
   b) The structure should now look like this: **UserControl** -> **LayoutRoot** -> **Grid** -> **Elements**
   c) Give a name for **LayoutRoot** and **Grid** by double-clicking on the names

10. **EB: Texts and values**

    - Dynamic and static texts are labeled with text fields
• Values (numbers) are issued with **Labels**

11. **EB: Insert labels**

• Labels replace numbers that are to be subsequently linked using INT variables (must be carried out for all number elements)

12. **EB: Set property**

• To display 100%, set the bar graph element's `MaxHeight` property to 341 (the maximum height of the indicator element is 340)

13. **EB: prepare for use in zenon**

   a) Delete all name labels (names may only be given for elements that are to be addressed via zenon)
   
   b) Save the XAML file with any desired name
   
   c) Integrate the XAML file into zenon (on page 141)

**A tip for checking:** If the XAML file is displayed with no problems in Microsoft Internet Explorer and the window size of Internet Explorer adapts to it, it will also be correctly used in zenon.

### 6.3 Engineering in zenon

To use WPF with zenon, Microsoft Framework 3.5 must be installed on both the editor computer and on Runtime.
CONDITIONS FOR WPF DISPLAY IN ZENON

The animation is currently available for simple variables; arrays and structures cannot be animated. Therefore the following WPF functions can be implemented in zenon:

- Element properties that correspond to simple data types, such as String, Int, Bool etc.
- Element properties of the "Object" type, which can be set with simple data types
- Element events can be used with functions; the parameters of the events are not however available in and cannot be evaluated in zenon
- Element transformation, for which a render transform is present for the element in the XAML file

Attention: if the content is outside of the area of the WPF element during transformation, this part of the content is lost or is not labeled

Notes on dBase: No shade can be displayed in zenon for WPF elements.

Attention

If the Runtime files were created for a project for a version before 6.50, existing WPF elements are not included into Runtime screens.

DISPLAY UNDER WINDOWS VISTA/WINDOWS 7

If a WPF screen contains a slider and Windows Vista or Windows 7 Aero Effects are used, this may lead to refresh problems in zenon Editor.

6.3.1 create WPF element

To create a WPF element

1. in the elements toolbar, select the symbol for WPF element or the Elements entry in the menu
2. select the start point in the main window
3. pull open the element with the mouse
4. In properties, select **Representation** the property **XAML file in the group**

5. The file selection dialog opens

6. Select the desired file
   Files of the following formats are valid
   - *.xaml: Extensible Application Markup Language
   - *.cdwpf: WPF collective file, also shows preview image
   (the file must already be present in the Project Manager under **Files/graphics** or created in the dialog.)

7. Configure the link (on page 104)

   ![Information]

   *If referenced objects (assemblies) are used in WPF, note the instructions in the Referenced objects (on page 85) chapter.*

### 6.3.2 CDWPFS files (collective files)

Rules for the use of collective files:

- The files can be in the ZIP file directly or in a joint folder.
- The name of the XAML file should correspond to the names of the collective file.
- Only one XAML file may be contained.
- The preview graphic should be small and no more than 64 pixels high. Name of the preview file: **preview.png** or the name of the XAML file with the suffix **.png**.
- Any number of assemblies can be used. The distinction is made on the basis of the file version in numerical form.
- Collective files do not need to contain an assembly.
- All folders are searched and only **.dll**, **.xaml** and **.png** files are taken into account.
- If a collective file (.cdwpf) is replaced by a file with a different version, all corresponding CDWPFS files in all symbols and images in all projects must be adapted.
6.3.3 Configuration of the linking

To configure a WPF element

1. In properties, select the Configuration property in the Display group

2. The dialog with three tabs opens with a preview of the XAML file and the elements present in the file.
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Existing elements</td>
<td>Shows the named file elements in a tree structure. The selected element can be linked with process data. WPF is assigned to process data based on the element name. Therefore elements are only shown if they and the attendant elements have a name. Allocations are configured and shown in the Properties, Events, Transformations tabs.</td>
</tr>
<tr>
<td>Preview</td>
<td>The selected element is shown flashing in the preview.</td>
</tr>
<tr>
<td>Properties (on page 105)</td>
<td>Configuration and display of properties (variables, authorizations, interlockings, linked values).</td>
</tr>
<tr>
<td>Events (on page 113)</td>
<td>Configuration and display of events (functions).</td>
</tr>
<tr>
<td>Transformations (on page 115)</td>
<td>Configuration and display of transformations.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the property.</td>
</tr>
<tr>
<td>Connection</td>
<td>Selection of link.</td>
</tr>
<tr>
<td>Link type</td>
<td>Type of link (variable, authorization, function)</td>
</tr>
<tr>
<td>WPF info</td>
<td>Shows the current value for properties in WPF content. For the user, it is directly visible what type of property it is (Boolean, string, etc.).</td>
</tr>
<tr>
<td>Linked</td>
<td>Shows if a property is currently being used. Not contained by default in the view, but can be selected using Context menu-&gt;Column selection.</td>
</tr>
</tbody>
</table>

**Information**

*Only logical objects can be displayed in the configuration dialog. Visual objects are not displayed. You can read about backgrounds and how visual objects can be animated in the Allocation of zenon object to WPF content (on page 86).*

**Properties**

The properties enable the linking of:
- Variables (on page 108)
- Values (on page 109)
- Authorizations and interlockings (on page 111)
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the property.</td>
</tr>
<tr>
<td>Connection</td>
<td>Linked variable, authorization or linked value.</td>
</tr>
<tr>
<td></td>
<td>Clicking in the column opens the respective selection dialog, depending on</td>
</tr>
<tr>
<td></td>
<td>the entry in the Link type column.</td>
</tr>
<tr>
<td>Link type</td>
<td>Selection of linking.</td>
</tr>
<tr>
<td>WPF info</td>
<td>Shows the current value for properties in WPF content.</td>
</tr>
<tr>
<td></td>
<td>For the user, it is directly visible what type of property it is (Boolean,</td>
</tr>
<tr>
<td></td>
<td>string, etc.).</td>
</tr>
<tr>
<td>Linked</td>
<td>Shows if a property is currently being used.</td>
</tr>
<tr>
<td></td>
<td>Not contained by default in the view, but can be selected using Context</td>
</tr>
<tr>
<td></td>
<td>menu-&gt;Column selection.</td>
</tr>
</tbody>
</table>

**CREATE LINK**

To create a link:

1. Highlight the line with the property that is to be linked
2. Click in the Link type cell
3. select the desired link from the drop-down list.

Available are:
- `<not linked>` (deletes an existing link)
- Authorization/interlocking
- Variable
- Value linking
4. Click in the Link cell
5. The dialog for configuring the desired link opens
**Information**

*Properties of WPF and zenon can be different. If, for example the visibility property is linked, there are three values available in .NET:*

- 0 - visible
- 1 - invisible
- 2 - collapsed

*These values must be displayed via the linked zenon variable.*

**Link variable**

To link a variable with a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type cell**
3. Select from the **variable** drop down list
4. Click in the **Link cell**
5. The dialog for configuring the variables opens

This dialog also applies for the selection of variables with transformations (on page 115). The configuration also makes it possible to convert from zenon into WPF units.
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked variables</td>
<td>Selection of the variable to be linked. A click on the ... button opens the selection dialog.</td>
</tr>
<tr>
<td>Value range of WPF element</td>
<td>Data to convert variable values into WPF values.</td>
</tr>
<tr>
<td>Convert value range</td>
<td>Active: WPF unit conversion is switched on.</td>
</tr>
<tr>
<td></td>
<td><strong>Effect on Runtime:</strong> The current zenon value (incl. zenon unit) is converted to the WPF range using standardized minimum and maximum values.</td>
</tr>
<tr>
<td></td>
<td><strong>For example:</strong> The value of a variable varies from 100 to 200. With the variables, the standardized range is set to 100 - 200. The aim is to display this change in value using a WPF rotary knob. For this:</td>
</tr>
<tr>
<td></td>
<td>- for <strong>Transformations</strong>, the RotateTransform.Angle property is linked to the variables</td>
</tr>
<tr>
<td></td>
<td>- <strong>Adjust value activated</strong></td>
</tr>
<tr>
<td></td>
<td>- a WPF value range of 0 to 360 is configured</td>
</tr>
<tr>
<td></td>
<td>Now the rotary knob can be turned at a value of 150, for example, by 180 degrees.</td>
</tr>
<tr>
<td>Minimum</td>
<td>Defines the lowest WPF value.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Defines the highest WPF value.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts settings and ends the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards settings and ends the dialog.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>

**Link values**

Linked values can either be a `string` or a numerical value of the `double` type. When selecting the screen, the selected value is sent in WPF content after loading the WPF content.
Attention

The data type of the WPF property need not necessarily be double or string. However only values of the string type or double are sent by zenon. These must be converted to .NET on the WPF page. For details see the Value transfer from zenon to WPF (on page 84) chapter.

To link a value with a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the Link type cell
3. Select Value linkings from the drop-down list
4. Click in the Link cell
5. The dialog for configuration of value linking opens
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked value:</td>
<td>Entry of a numerical value or string value.</td>
</tr>
<tr>
<td>Use string</td>
<td><strong>Active:</strong> A string value is used instead of a numerical value.</td>
</tr>
<tr>
<td></td>
<td>The language of string values can be switched. The text is</td>
</tr>
<tr>
<td></td>
<td>translated in Runtime when the screen is called up and sent in WPF content.</td>
</tr>
<tr>
<td></td>
<td>If the language is switched whilst the screen is opened, the string value</td>
</tr>
<tr>
<td></td>
<td>is retranslated and sent.</td>
</tr>
<tr>
<td>String value/numerical value</td>
<td>Depending on what is selected for the <strong>Use string</strong> property, a numerical</td>
</tr>
<tr>
<td></td>
<td>value or a string value is entered into this field. For numerical values,</td>
</tr>
<tr>
<td></td>
<td>a unit of measurement can also be selected.</td>
</tr>
<tr>
<td>Unit:</td>
<td>Selection of a unit of measurement from the drop down list. You must</td>
</tr>
<tr>
<td></td>
<td>have configured this in unit switching beforehand.</td>
</tr>
<tr>
<td></td>
<td>The unit of measurement is allocated with the numerical value. If the</td>
</tr>
<tr>
<td></td>
<td>units are switched in Runtime, the value is converted to the new unit of</td>
</tr>
<tr>
<td></td>
<td>measurement and sent to WPF content.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts settings and ends the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards settings and ends the dialog.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>

**Link authorization or interlocking**

Authorizations cannot be granted for the whole WPF element. The element is allocated a user level. Authorizations are granted within the user level for individual controls. If an authorization is active, the value 1 is written to the element.

To link an authorization or interlocking with a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type cell**
3. Select **Authorization/interlocking** from the drop down menu
4. Click in the **Link cell**
5. The dialog for configuring the authorizations opens

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link authorization/interlocking</td>
<td>Setting the authorizations.</td>
</tr>
<tr>
<td>Linked status</td>
<td>selection of an authorization that is linked to a WPF control from the drop down list. For example, visibility and operability of a WPF button can depend on a user’s status.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorization granted</td>
<td>If the user has sufficient rights to operate the WPF element, a value of 1 is written to the property.</td>
</tr>
<tr>
<td>Authorization not present</td>
<td>If the user does not have sufficient rights to operate the WPF element, a value of 1 is written to the property.</td>
</tr>
<tr>
<td>Not locked</td>
<td>If the element is not locked, the value 1 is written to the property.</td>
</tr>
<tr>
<td>Locked</td>
<td>If the element is locked, the value 1 is written to the property.</td>
</tr>
<tr>
<td>Operable</td>
<td>If authorization is present and the element is not locked, then a value of 1 is written to the property.</td>
</tr>
<tr>
<td>Not operable</td>
<td>If authorization is not present or the element is not locked, then a value of 1 is written to the property.</td>
</tr>
</tbody>
</table>
Events

Events make it possible to link zenon functions to a WPF element.
## Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the property.</td>
</tr>
<tr>
<td>Connection</td>
<td>Linked function. Clicking in the cell opens the configuration dialog.</td>
</tr>
<tr>
<td>Link type</td>
<td>Selection of linking. Clicking in the cell opens the selection dialog.</td>
</tr>
<tr>
<td>WPF info</td>
<td>Shows the current value for properties in WPF content.</td>
</tr>
<tr>
<td></td>
<td>For the user, it is directly visible what type of property it is (Boolean, string, etc.).</td>
</tr>
<tr>
<td>Linked</td>
<td>Shows if a property is currently being used.</td>
</tr>
<tr>
<td></td>
<td>Not contained by default in the view, but can be selected using Context menu-&gt;Column selection.</td>
</tr>
</tbody>
</table>

### LINK FUNCTIONS

To create a link:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type** cell
3. Select from the drop down list function
4. Click in the **Link** cell
5. The dialog for configuring the function opens
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked function</td>
<td>Selection of the function to be linked. Clicking on the ... button opens the dialog for Function selection.</td>
</tr>
<tr>
<td>OK</td>
<td>Accepts selection and closes dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards changes and closes the dialog.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>

### Transformation

The **WPF element does not support rotation**. If, for example, the **WPF element is in a symbol and the symbol is rotated**, the **WPF element does not rotate with it**. Therefore there is a different mechanism for **Transformation with WPF** to turn elements or to otherwise transform them. These transformations are configured in the **Transformation** tab.

**Attention**: If the content is outside of the **WPF element area**, this part of the contents is lost, i.e. it is not shown.
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the property.</td>
</tr>
</tbody>
</table>
| Connection | Selection of the linked variables.  
Transformations are displayed in XAML as transformation objects with their own properties. If an element supports a transformation, then the possible properties of the transformation object are displayed in list view. (more on this in: Integrate button as WPF XAML in zenon (on page 134)  
For example, if the linked variable is set at the value of 10, then this value is written as a WPF target and the WPF element is rotated by 10°. |
| Link type  | Selection of transformation link type. |
| WPF info   | Shows the current value for properties in WPF content. For the user, it is directly visible what type of property it is (Boolean, string, etc.). |
| Linked     | Shows if a property is currently being used.  
Not contained by default in the view, but can be selected using Context menu->Column selection. |

### LINK TRANSFORMATIONS

To link a transformation with a WPF property:

1. Highlight the line with the property that is to be linked
2. Click in the **Link type** cell
3. Select from the **Transformation** drop down list
4. Click in the **Link** cell
5. The dialog for configuring the variables opens
The configuration also makes it possible to convert from zenon into WPF units.
Parameters | Description
--- | ---
Linked variables | Selection of the variable to be linked. A click on the ... button opens the selection dialog.
Value range of WPF element | Data to convert variable values into WPF values.
Convert value range | Active: WPF unit conversion is switched on.
Effect on Runtime: The current zenon value (incl. zenon unit) is converted to the WPF range using standardized minimum and maximum values.

For example: The value of a variable varies from 100 to 200. With the variables, the standardized range is set to 100 - 200. The aim is to display this change in value using a WPF rotary knob. For this:

- for Transformations, the RotateTransform.Angle property is linked to the variables
- Adjust value activated
- a WPF value range of 0 to 360 is configured

Now the rotary knob can be turned at a value of 150, for example, by 180 degrees.

Minimum | Defines the lowest WPF value.
Maximum | Defines the highest WPF value.
OK | Accepts settings and ends the dialog.
Cancel | Discards settings and ends the dialog.
Help | Opens online help.

6.3.4 Validity of XAML Files

XAML files are valid subject to certain requirements:

- correct name space
CORRECT NAME SPACE

The WPF element can only display WPF content, i.e.:

Only XAML files with the correct WPF namespace can be displayed by the WPF element. Files that use a Silverlight namespace cannot be loaded or displayed. However, in most cases it is suffice to change the Silverlight namespace to the WPF namespace.

WPF namespace:

```xml
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
```

NO USE OF CLASS REFERENCES

Because the XAML files can be loaded dynamically, it is not possible to use XAML files that contain references to classes ("class" key in header). Functions that have been programmed in independently-created C#- files cannot be used.

SCALABILITY

If the content of a WPF element is adjusted to the size of the WPF element, then the controls of the WPF element are interlaced in a control that offers this functionality, such as a view box for example. In addition, care must be taken to ensure that the height and width elements are configured as automatic.

CHECKING AN XAML FILE TO SEE IF IT IS CORRECT

To check if an XAML file has the correct format:

- Open the XAML file in Internet Explorer
  - If it can be opened without additional plug-ins (Java or similar), then it can be assumed with a high degree of certainty that this file can be loaded and displayed by zenon
  - if problems occur during loading, these are then shown in Internet Explorer and the lines in which problems arise can be clearly seen
The scaling can also be tested in this manner: If the file has been created correctly, the content will adjust to the size of the Internet Explorer window.

**ERROR MESSAGE**

If an invalid file is used in zenon, then an error message is displayed in the output window when loading the file in the WPF element.

For example:

"error when loading
xaml-Datei:C:\ProgramData\COPA-DATA\SQL\781b1352-59d0-437e-a173-08563c3142e9\FILES\zenon\custom\media\UserControl1.xaml

The attribute "Class" cannot be found in XML namespace "http://schemas.microsoft.com/winfx/2006/xaml". Line 7 Position 2."

### 6.3.5 Pre-built elements

zenon is already shipped with several WPF elements. More are available for download in the web shop.

All WPF elements have properties which determine the graphical design of the respective element (Dependency Properties). Setting the values via an XAML file or linking the property via zenon can directly change the look in the Runtime. The following tables contain the respective Dependency Properties, depending on the control.

Elements:

- Round display (on page 122)
- Progress bar (on page 127)
- Vertical bar graph (on page 128)
- Temperature control (on page 129)
- Analog clock (on page 130)
- Universal slider (on page 131)
REPLACING ASSEMBLY WITH A NEWER VERSION

Per project only one assembly for a WPF element can be used in the Editor as well as the Runtime. If two versions of an assembly are available in a project, then the first loaded file is used. A user enquiry is made as to which version should be used. No further actions are needed for the maintenance of the versions used up until now. If a newer version is chosen, all corresponding CDWPF files in all symbols and images in all projects must be adapted.

**Note for Multi-Project Administration:** If an assembly in a project is replaced by a new version, it must also be replaced in all other projects that are loaded in the Editor or in Runtime.
## Circular gauge control

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentValue</td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td>IsReversed</td>
<td>Scale orientation - clockwise or anti-clockwise</td>
<td>Boolean</td>
</tr>
<tr>
<td>ElementFontFamily</td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td>MinValue</td>
<td>Minimum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MaxValue</td>
<td>Maximum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleRadius</td>
<td>Radius of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleStartAngle</td>
<td>Angle at which the scale starts.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleLabelRotationMode</td>
<td>Alignment of the scale caption.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>▶ None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Automatic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Surround In</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Surround Out</td>
<td></td>
</tr>
<tr>
<td>ScaleSweepAngle</td>
<td>Angel area which defines the size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleLabelFontSize</td>
<td>Font size of the scale caption.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleLabelColor</td>
<td>Font color of the scale caption.</td>
<td>Color</td>
</tr>
<tr>
<td>ScaleLabelRadius</td>
<td>Radius on which the scale caption is orientated.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleValuePrecision</td>
<td>Accuracy of the scale caption.</td>
<td>Integer</td>
</tr>
<tr>
<td>PointerStyle</td>
<td>Shape of the pointer displaying the value.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>▶ Arrow</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▶ Rectangle</td>
<td></td>
</tr>
<tr>
<td>Triangle Cap</td>
<td>Pentagon</td>
<td>Triangle</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>MajorTickColor</td>
<td>Color of main ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>MinorTickColor</td>
<td>Color of sub ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>MajorTickSize</td>
<td>Size of main ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MinorTickSize</td>
<td>Size of sub ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MajorTicksCount</td>
<td>Number of main ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>MajorTicksShape</td>
<td>Shape/type of main ticks on the scale.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>▪ Rectangle</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Trapezoid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Triangle</td>
<td></td>
</tr>
<tr>
<td>MinorTicksShape</td>
<td>Shape/type of sub ticks on the scale.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>▪ Rectangle</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Trapezoid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Triangle</td>
<td></td>
</tr>
<tr>
<td>MinorTicksCount</td>
<td>Number of sub ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>PointerSize</td>
<td>Size of the pointer.</td>
<td>Size</td>
</tr>
<tr>
<td>PointerCapRadius</td>
<td>Size of the pointer fastening point.</td>
<td>Double</td>
</tr>
<tr>
<td>PointerBorderBrush</td>
<td>Color of pointer border.</td>
<td>Brush</td>
</tr>
<tr>
<td>PointerCapStyle</td>
<td>Shape/type of pointer fastening point.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>▪ BackCap</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ FrontCap</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ Screw</td>
<td></td>
</tr>
<tr>
<td>PointerCapBorderBrush</td>
<td>Color of pointer fastening point.</td>
<td>Brush</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>PointerBrush</td>
<td>Color of pointer.</td>
<td>Brush</td>
</tr>
<tr>
<td>GaugeBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
<tr>
<td>GaugeBackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>PointerCapColorBrush</td>
<td>Color of pointer fastening point.</td>
<td>Brush</td>
</tr>
<tr>
<td>GaugeMiddlePlate</td>
<td>Radius of the element background middle plate.</td>
<td>Double</td>
</tr>
<tr>
<td>PointerOffset</td>
<td>Offset of the pointer (displacement).</td>
<td>Double</td>
</tr>
<tr>
<td>RangeRadius</td>
<td>Radius of the total range display.</td>
<td>Double</td>
</tr>
<tr>
<td>RangeThickness</td>
<td>Thickness of the total range display.</td>
<td>Double</td>
</tr>
<tr>
<td>RangeStartValue</td>
<td>Start value of the total range display.</td>
<td>Double</td>
</tr>
<tr>
<td>Range1EndValue</td>
<td>End value of the 1st area and start value of the 2nd range.</td>
<td>Double</td>
</tr>
<tr>
<td>Range2EndValue</td>
<td>End value of the 2nd area and start value of the 3rd range.</td>
<td>Double</td>
</tr>
<tr>
<td>Range3EndValue</td>
<td>End value of the 3rd area and start value of the 4th range.</td>
<td>Double</td>
</tr>
<tr>
<td>Range4EndValue</td>
<td>End value of the 4th area and start value of the 5th range.</td>
<td>Double</td>
</tr>
<tr>
<td>Range5EndValue</td>
<td>End value of the 5th area and start value of the 6th range.</td>
<td>Double</td>
</tr>
<tr>
<td>Range6EndValue</td>
<td>End value of the 6th range.</td>
<td>Double</td>
</tr>
<tr>
<td>Range1ColorBrush</td>
<td>Color of the first range.</td>
<td>Brush</td>
</tr>
<tr>
<td>Range2ColorBrush</td>
<td>Color of the second range.</td>
<td>Brush</td>
</tr>
<tr>
<td>Range3ColorBrush</td>
<td>Color of the third range.</td>
<td>Brush</td>
</tr>
<tr>
<td>Range4ColorBrush</td>
<td>Color of the fourth range.</td>
<td>Brush</td>
</tr>
<tr>
<td>Range5ColorBrush</td>
<td>Color of the fifth range.</td>
<td>Brush</td>
</tr>
<tr>
<td>Range6ColorBrush</td>
<td>Color of the sixth range.</td>
<td>Brush</td>
</tr>
<tr>
<td>ScaleOuterBorderBrush</td>
<td>Color of the scale border.</td>
<td>Brush</td>
</tr>
<tr>
<td>ScaleBackgroundBrush</td>
<td>Color of scale background.</td>
<td>Brush</td>
</tr>
<tr>
<td><strong>ValueTextFrameStyle</strong></td>
<td>Shape/type of value display.</td>
<td>Enum:</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------</td>
<td>-------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• LargeFrame</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SmallFrame</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• None</td>
</tr>
<tr>
<td><strong>ValueTextContent</strong></td>
<td>Content of the value display.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Text</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• TextValue</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Value</td>
</tr>
<tr>
<td><strong>ValueTextSize</strong></td>
<td>Font size of the value display.</td>
<td>Double</td>
</tr>
<tr>
<td><strong>ValueTextColor</strong></td>
<td>Font size of the value display.</td>
<td>Color</td>
</tr>
<tr>
<td><strong>IsGlasReflection</strong></td>
<td>Activate the glass effect on the element.</td>
<td>Boolean</td>
</tr>
<tr>
<td><strong>GaugeOffset</strong></td>
<td>Lowering the rotation point of the whole element.</td>
<td>Double</td>
</tr>
</tbody>
</table>
Progress bar - ProgressBarControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentValue</td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td>MinValue</td>
<td>Minimum value of the value area.</td>
<td>Double</td>
</tr>
<tr>
<td>MaxValue</td>
<td>Maximum value of the value area.</td>
<td>Double</td>
</tr>
<tr>
<td>ProgressBarDivisionCount</td>
<td>Number of divisions of the progress bar.</td>
<td>Integer</td>
</tr>
<tr>
<td>VisibilityText</td>
<td>Visibility of the value display.</td>
<td>Boolean</td>
</tr>
<tr>
<td>TextSize</td>
<td>Font size of the value display.</td>
<td>Double</td>
</tr>
<tr>
<td>TextColor</td>
<td>Color of the value display.</td>
<td>Color</td>
</tr>
<tr>
<td>ProgressBarBoxedColor</td>
<td>Color of the border of the progress bar.</td>
<td>Color</td>
</tr>
<tr>
<td>ProgressBarMarginDistance</td>
<td>Distance of the progress bar box from the element edge (left, top, right, down).</td>
<td>Double</td>
</tr>
<tr>
<td>ProgressBarInactiveBrush</td>
<td>Indicator color not active.</td>
<td>Brush</td>
</tr>
<tr>
<td>ProgressBarActiveBrush</td>
<td>Indicator color active.</td>
<td>Brush</td>
</tr>
<tr>
<td>ProgressBarPadding</td>
<td>Distance of the progress bar from the progress bar box (left, top, right, down).</td>
<td>Double</td>
</tr>
<tr>
<td>ElementBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementBackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
</tbody>
</table>
## Bar graph vertical - VerticalBargraphControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentValue</td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td>MinValue</td>
<td>Minimum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MaxValue</td>
<td>Maximum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MajorTicksCount</td>
<td>Number of main ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>MinorTicksCount</td>
<td>Number of sub ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>MajorTickColor</td>
<td>Color of main ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>MinorTickColor</td>
<td>Color of sub ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>ElementBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementBackgroundColor</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementGlassReflection</td>
<td>Activate the glass effect on the element.</td>
<td>Visibility</td>
</tr>
<tr>
<td>ElementFontFamily</td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td>ScaleFontSize</td>
<td>Font size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleFontColor</td>
<td>Font color of the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>IndicatorBrush</td>
<td>Bar graph fill color.</td>
<td>Brush</td>
</tr>
<tr>
<td>BargraphSeparation</td>
<td>Number of bar graph division.</td>
<td>Integer</td>
</tr>
<tr>
<td>BargraphSeparationColor</td>
<td>Color of the scale division.</td>
<td>Color</td>
</tr>
</tbody>
</table>
## Temperature indicator - TemperatureIndicatorControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentValue</td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td>MinValue</td>
<td>Minimum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MaxValue</td>
<td>Maximum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MajorTicksCount</td>
<td>Number of main ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>MinorTicksCount</td>
<td>Number of sub ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>TickNegativColor</td>
<td>Color of the negative main tick (gradient to TickPositivColor).</td>
<td>Color</td>
</tr>
<tr>
<td>TickPositivColor</td>
<td>Color of the positive main tick (gradient to TickNegativColor).</td>
<td>Color</td>
</tr>
<tr>
<td>MinorTickColor</td>
<td>Color of the sub ticks.</td>
<td>Color</td>
</tr>
<tr>
<td>ElementBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementBackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementGlassReflection</td>
<td>Activate the glass effect on the element.</td>
<td>Visibility</td>
</tr>
<tr>
<td>ElementFontFamily</td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td>IndicatorColor</td>
<td>Color of the indicator fill color.</td>
<td>Color</td>
</tr>
<tr>
<td>IndicatorBorderColor</td>
<td>Color of the indicator border.</td>
<td>Color</td>
</tr>
<tr>
<td>MajorTickSize</td>
<td>Size of main ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MinorTickSize</td>
<td>Size of sub ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>ScaleLetteringDistance</td>
<td>Distance of the scale caption (vertical), each x. main tick should be captioned.</td>
<td>Integer</td>
</tr>
<tr>
<td>IndicatorScaleDistance</td>
<td>Distance between indicator and scale (horizontal).</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleFontSize</td>
<td>Font size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleFontColor</td>
<td>Font color of the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>Unit</td>
<td>Unit.</td>
<td>String</td>
</tr>
</tbody>
</table>
### Analog clock - AnalogClockControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ElementStyle</td>
<td>Shape/type of element.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>‣ SmallFrame</td>
</tr>
<tr>
<td></td>
<td></td>
<td>‣ Unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>‣ None</td>
</tr>
<tr>
<td>ElementBackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>ElementGlassReflection</td>
<td>Activate the glass effect on the element.</td>
<td>Visibility</td>
</tr>
<tr>
<td>Offset</td>
<td>Value in hours (h) which displays the time lag to the system clock.</td>
<td>Int16</td>
</tr>
<tr>
<td>OriginText</td>
<td>Text which is displayed in the clock (e.g. location).</td>
<td>String</td>
</tr>
</tbody>
</table>
### Universal slider - UniversalReglerControl

<table>
<thead>
<tr>
<th>Property</th>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentValue</td>
<td>Current value which should be displayed.</td>
<td>Double</td>
</tr>
<tr>
<td>ElementFontFamily</td>
<td>Element font.</td>
<td>Font</td>
</tr>
<tr>
<td>MinValue</td>
<td>Minimum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>MaxValue</td>
<td>Maximum value of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>Radius</td>
<td></td>
<td>Double</td>
</tr>
<tr>
<td>ScaleRadius</td>
<td>Radius of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleStartAngle</td>
<td>Angle at which the scale starts.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleLabelRotationMode</td>
<td>Alignment of the scale caption.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Automatic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- SurroundIn</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- SurroundOut</td>
<td></td>
</tr>
<tr>
<td>ScaleSweepAngle</td>
<td>Angel area which defines the size of the scale.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleLabelFontSize</td>
<td>Font size of the scale caption.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleLabelColor</td>
<td>Font color of the scale caption.</td>
<td>Color</td>
</tr>
<tr>
<td>ScaleLabelRadius</td>
<td>Radius on which the scale caption is orientated.</td>
<td>Double</td>
</tr>
<tr>
<td>ScaleValuePrecision</td>
<td>Accuracy of the scale caption.</td>
<td>Integer</td>
</tr>
<tr>
<td>ElementStyle</td>
<td>Display type of the element</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>- Knob</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Plate</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- None</td>
<td></td>
</tr>
<tr>
<td>MajorTickColor</td>
<td>Color of main ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>MinorTickColor</td>
<td>Color of sub ticks on the scale.</td>
<td>Color</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>MajorTickSize</td>
<td>Size of main ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MinorTickSize</td>
<td>Size of sub ticks on the scale.</td>
<td>Size</td>
</tr>
<tr>
<td>MajorTicksCount</td>
<td>Number of main ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>MajorTicksShape</td>
<td>Shape/type of main ticks on the scale.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>Rectangle</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Trapezoid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Triangle</td>
<td></td>
</tr>
<tr>
<td>MinorTicksShape</td>
<td>Shape/type of sub ticks on the scale.</td>
<td>Enum:</td>
</tr>
<tr>
<td></td>
<td>Rectangle</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Trapezoid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Triangle</td>
<td></td>
</tr>
<tr>
<td>MinorTicksCount</td>
<td>Number of sub ticks on the scale.</td>
<td>Integer</td>
</tr>
<tr>
<td>BackgroundBorderBrush</td>
<td>Color of the element border.</td>
<td>Brush</td>
</tr>
</tbody>
</table>
### WPF Element

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>BackgroundBrush</td>
<td>Color of element background.</td>
<td>Brush</td>
</tr>
<tr>
<td>PointerCapColorBrush</td>
<td>Color of pointer fastening point.</td>
<td>Brush</td>
</tr>
<tr>
<td>GaugeMiddlePlate</td>
<td>Radius of the element background middle plate.</td>
<td>Double</td>
</tr>
<tr>
<td>ValueFontSize</td>
<td>Font size of the value display.</td>
<td>Double</td>
</tr>
<tr>
<td>ValueFontColor</td>
<td>Font size of the value display.</td>
<td>Color</td>
</tr>
<tr>
<td>IsGlasReflection</td>
<td>Activate the glass effect on the element.</td>
<td>Boolean</td>
</tr>
<tr>
<td>KnobBrush</td>
<td>Color of the knob.</td>
<td>Brush</td>
</tr>
<tr>
<td>IndicatorBrush</td>
<td>Color of the indicator.</td>
<td>Brush</td>
</tr>
<tr>
<td>IndicatorBackgroundColor</td>
<td>Background color of the inactive indicator.</td>
<td>Brush</td>
</tr>
<tr>
<td>KnobSize</td>
<td>Diameter of the knob.</td>
<td>Double</td>
</tr>
<tr>
<td>KnobIndicatorSize</td>
<td>Indicator size of the knob.</td>
<td>Size</td>
</tr>
<tr>
<td>ElementSize</td>
<td>Size of the element.</td>
<td>Size</td>
</tr>
<tr>
<td>VisibilityKnob</td>
<td>Activating of the knob.</td>
<td>Boolean</td>
</tr>
<tr>
<td>ValuePosition</td>
<td>Position of the value display.</td>
<td>Double</td>
</tr>
<tr>
<td>ValueVisibility</td>
<td>Activating the value display.</td>
<td>Boolean</td>
</tr>
</tbody>
</table>

#### 6.3.6 Examples: Integration of WPF in zenon

You can see how XAML files are created and integrated as WPF elements in zenon from the following examples:

- Integrate button as WPF XAML in zenon (on page 134)
- Integrate bar graph as WPF XAML in zenon (on page 141)
- Integrate DataGrid Control in zenon (on page 146)
Integrate button as WPF XAML in zenon

Example structure:

- Creating a button (on page 89) in Microsoft Expression Blend
- Integrate into zenon
- Link to a variable and a function
- adjust the button to the size of the element
- Create button

As a first step, create a button as described in the Create button as XAML file with Microsoft Expression Blend (on page 89) chapter. To be able to use the XAML file in zenon, insert this in the project tree in the Files/graphics folder.

INTEGRATE BUTTON

Note: A zenon project with the following content is used for the following description:

- An empty screen as a start screen
- an internal variable int of type Int
- a function Funktion_0 of type Send value to hardware with:
  - Direct to hardware option activated
  - Set was set to 45

To integrate the button:

1. open the empty screen
2. place a WPF element (on page 102) in the screen
3. select XAML file in the properties window
4. select the XAML file (e.g. MyButton.xaml) and close the dialog
5. select the Configuration property
CONFIGURE THE BUTTON

The configuration dialog shows a preview of the selected XAML file. All elements named in the XAML file are listed in the tree:

1. select the WPF button, which is in LayoutRoot->MyViewBox->MyButton
2. Look in the Properties Entry Content tab; this contains the button's text
3. Click the Link type column
4. Select Variable from the drop down list
5. Click in the Link column
6. the variable selection dialog is opened
7. select the int variable to link this variable with the Content property

EVENTS

To also assign events:
1. select the events tab

![WPF Element Configuration](image)

2. look for the 'Click' entry, this event is triggered by the WPF element, as soon as the button is clicked

3. Click in the Link type column

4. Select Function from the drop down list

5. Click in the Link column

6. the function selection dialog is opened

7. select Function_0

8. Confirm the changes with OK

9. Insert a numerical value element into the screen

10. Link this numerical value element to the int variables too.

11. Compile the Runtime files and start Runtime.
The WPF element is displayed in Runtime, the button text is 0. As soon as you click on the button, the click event is triggered and the set value function is carried out. The value 45 is sent directly to the hardware and both numerical value and button display the value 45.

![WPF Element Image]

Define a set value of 30 via the numerical value element; this value is then also assumed by the WPF element.

**AUTHORIZATION**

Similar to a numerical value, a WPF element can be locked according to authorizations (lock symbol) or switched to be operable. Set the user authorization level to 1 for the WPF element and create a user called Test with authorization level 1. In addition, set up the functions Login with dialog and Logout. You link these two functions with 2 new text buttons on the screen.
In the WPF element configuration dialog, select the MyButton WPF button and select the Properties: tab.

1. Select the IsEnabled element
2. Click in the Link type column
3. Select Authorizations/interlocking from the drop down list
4. Click in the Link column
5. In the drop-down list, select the Authorized option
6. Close the dialog with ok
Compile the Runtime file and note that Authorizations to be Transferred must also be selected. After Runtime has been started, the WPF button is displayed as deactivated on the screen and cannot be operated. If you now log in as the user Test, the button is activated and can be operated. The button is locked again as soon as you log out.

**TRANSFORMATION**

The XAML files must still be adapted to use transformations:

1. switch to the **Expression Blend** program

2. select **MyButton**, so that the properties of the element are visible in the events window

3. **Under Transform at RenderTransform** select the **Apply relative transform option**

As a result of this, a block is inserted into the XAML file, which save the transformation settings in runtime.

```xml
<Button.RenderTransform>
  <TransformGroup>
    <ScaleTransform ScaleX="1" ScaleY="1"/>
    <SkewTransform AngleX="0" AngleY="0"/>
    <RotateTransform Angle="0"/>
    <TranslateTransform X="0" Y="0"/>
  </TransformGroup>
</Button.RenderTransform>
```

4. Save the file and replace the old version in zenon with this new file.

5. **Open the WPF element configuration dialog again:**
a) select the MyButton button
b) select the Transformations tab
c) select the RotateTransform.Angle element
d) Click in the Link type column
e) Select Transformations from the drop down list
f) Click in the Link column
g) the variable selection dialog is opened
h) select the int variable to link this variable with the RotateTransform.Angle property
Compile the Runtime files and start Runtime. Log in as the Test user and click on the button. The button has the value 45 and the WPF element rotates by 45°.

Integrate bar graph as WPF XAML in zenon

Example structure:

- Creating a bar graph (on page 93) in Adobe Illustrator and converting it to WPF
- Integrate into zenon
- Linking with variables
- Adapting the bar graph WPF element

CREATE BAR GRAPH

The first step is to generate a bar graph as described in the Workflow with Adobe Illustrator (on page 93) chapter. To be able to use the XAML file in zenon, insert this in the project tree in the Files/graphics folder.

INTEGRATE BAR GRAPH

Note: A zenon project with the following content is used for the following description:

- An empty screen as a start screen
- Four variables from the internal driver for
  - Scale 0
  - Scale central
- Scale high
- Current value
  - A variable from the mathematics driver for displaying the current value (255)

To integrate the bar graph:

1. open the empty screen
2. place a WPF element (on page 102) in the screen
3. select XAML file in the properties window
4. Select the desired XAML file (for example bar_graph_vertical.xaml) and close the dialog

ADJUST BAR GRAPH

Before configuration, the scale of the XAML file is adapted if necessary:

To do this:

- Create a new mathematics variable that calculates the new value in relation to the scaling, for example:
• Variable: 0-1000
• Mathematic variable (value created in xaml file)*Variable/1000

The XAML file is then configured.

**CONFIGURE BAR GRAPH**

1. Click on the WPF element and select the **Configuration** property
2. The configuration dialog shows a preview of the selected XAML file.
3. Select the minimum value, the average value and the maximum value and link each of these to the corresponding variable in the `Content` property.
4. Select the \textit{Slider} and link the \texttt{Value} property to the mathematics variables (in our example: calculation)
5. Check the project planning in Runtime:

Integrate DataGrid Control in zenon

To create DataGrid control, you need:

- Visual Studio

Ensure that you always create projects that are based on .NET Framework 3.5.

CREATE WPF USER CONTROL

1. Create a WPF User Control in Visual Studio.
In our example, it is given the name MyWPFLibrary.

2. Add the WPF Toolkit assemblies to the references. To do this:
   a) Right-click on the project
   b) Select Add reference...
   c) Select this in the .NET tab
   d) Select System.Data and System.Data.DataSetExtensions too if these are not already present

3. Create a new data connection in Server Explorer. To do this:
   a) right-click on Data Connections
   b) Select Add connection...

   In our example, the database Northwind is used; this has been created by Microsoft as an example database.
After adding the connection, the Server Explorer window should look a little like this:

A new DataSet is created in the next step.

CREATING A DATASET

1. Right-click on the project

2. In the context menu, select the **Add New Item...**

3. Create a new DataSet.

4. Double-click the DataSet. It should now open in the designer.
5. Drag the tables that you need into the DataSet design window.

The XAML file is configured in the next step.

**CONFIGURATION OF XAML FILE**

1. Insert the **namespaces** into the XAML file.

   You need the **namespace** of the WPF toolkits and a reference to the class:

   ```xml
   <UserControl.Resources>
   <my1:MyDataSet x:Key="MyDataSet"/>
   <CollectionViewSource x:Key="customersViewSource" Source="{Binding Path=Customers, Source={StaticResource MyDataSet}}"/>
   </UserControl.Resources>
   ```

2. Define the resources and the DataGrid that is to be used in the WPF:

   ```xml
   <UserControl.Resources>
   <my1:MyDataSet x:Key="MyDataSet" />
   <CollectionViewSource x:Key="customersViewSource" Source="{Binding Path=Customers, Source={StaticResource MyDataSet}}" />
   </UserControl.Resources>
   <Grid DataContext="{StaticResource customersViewSource}"
   <my:DataGrid Height="304" HorizontalAlignment="Left" Margin="6,7,0,0" Name="dataGrid1" VerticalAlignment="Top" Width="497"/>
DisplayMemberPath="CompanyName" ItemsSource="{Binding}"
SelectedValuePath="CustomerID" />

3. Open the code-behind file (xaml.cs) and insert the following lines in the constructor:

```csharp
public UserControl1()
{
    InitializeComponent();
    MyWPFLibrary.MyDataSet ds =
    ((MyWPFLibrary.MyDataSet)this.FindResource("MyDataSet"));
    MyWPFLibrary.MyDataSetTableAdapters.CustomersTableAdapter ta = new
    MyWPFLibrary.MyDataSetTableAdapters.CustomersTableAdapter();
    ta.Fill(ds.Customers);
    System.Windows.DataCollectionViewSource customersViewSource =
    customersViewSource.View.MoveCurrentToFirst();
}
```

This has the following effect:

- Get DataSet
- Create a new ReportAdapter
- Fill DataSet
- Provide this information to the DataGrid Control

The solution can now be built.

**BUILD**

Now create the solution Some DLLs are created in the output folder in the process.

You now have a DLL with the necessary functionality available. However zenon can only display XAML files that cannot be linked to the code-behind file. Therefore another DLL is required that references the DLL that has just been built. To do this:

1. Create another project, another WPF user control library.
2. It was called **DataGridControl** in our example.

3. Insert a reference to the project that has just been built into this new project.

4. The XAML files looks as follows:

```xml
<UserControl x:Class="test.UserControl1"
    xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
    xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
    xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
    mc:Ignorable="d"
    d:DesignHeight="300" d:DesignWidth="300">
    <Grid>
    </Grid>
</UserControl>
```

5. Because all necessary content is contained in the DLL and no code-behind is necessary, delete:

   ```xml
   x:Class="test.UserControl1"
   ```

6. Also delete (for the positioning) the following lines

   ```xml
   mc:Ignorable="d"
   d:DesignHeight="300" d:DesignWidth="300"
   ```

7. Define what is to be displayed in the XAML file. To do this, add the following lines:

```xml
<UserControl xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
    xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
    xmlns:d="http://schemas.microsoft.com/expression/blend/2008">
```


xmlns:mywpflib="clr-namespace:MyWPFLibrary;assembly=MyWPFLibrary">

<Grid x:Name="GridName">
<mywpflib:UserControl1 HorizontalAlignment="Left" Name="userControl11" VerticalAlignment="Top"/>
</Grid>
</UserControl>

The xmlns:mywpflib="clr-namespace:MyWPFLibrary;assembly=MyWPFLibrary" line defines the namespace mywpflib and stipulates that this should use the assembly built before.

8. Insert a pre-existing name into the TAGs of the grid.

9. Insert the control mywpflib:UserControl1 from our library and give it a name, because zenon can only modify objects that have a name.

10. Construct this solution.
    This now leads to an error message:

11. To rectify the error, simply delete the code-behind file and carry out a rebuild.

In the next step, the XAML file is added in zenon.

**STEPS IN ZENON**

1. Open the zenon Editor

2. Go to File -> Graphics

3. Select Add file... in the context menu
4. Select the XAML file from the save location and insert this.

5. Insert the DLLs with the functionality for the XAML file. To do this:
   a) Select, in the context menu, File -> Other Add file...
   b) Select the WPFToolkit.dll and the DLL of the first project

6. Create a screen.
7. Insert a WPF element and select an XAML file. You should now see the following:

Note: If the XAML file is to be deleted or updated within the zenon project, it may be the case that the DLLs are still open and cannot be deleted from the file folder. The editor must be restarted in order to delete them. It may also be sufficient to deactivate the project and reactivate it again.
6.3.7 Troubleshooting

ENTRIES IN LOG FILES

<table>
<thead>
<tr>
<th>Entry</th>
<th>Level</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>XAML file found in %s with different name, using default!</td>
<td>Warning</td>
<td>The name of the collective file and the name of the XAML file contained therein do not correspond. To avoid internal conflicts, the file with the name of the collective file and the suffix .xaml is used.</td>
</tr>
<tr>
<td>No preview image found in %s</td>
<td>Warning</td>
<td>The collective file does not contain a valid preview graphic (preview.png or [names of the XAML file].png). Thus no preview can be displayed.</td>
</tr>
<tr>
<td>XAML file in %s not found or not unique!</td>
<td>Errors</td>
<td>The collective file does not contain an XAML file or several files with the suffix .xaml. It cannot be used.</td>
</tr>
<tr>
<td>Could not remove old assembly %s</td>
<td>Warning</td>
<td>There is an assembly that is to be replaced with a newer version, but cannot be deleted.</td>
</tr>
<tr>
<td>Could not remove old assembly %s</td>
<td>Errors</td>
<td>A new version is available for an assembly in the work folder, but it cannot be copied there. Possible reason: The old example is still loaded, for example. The old version continues to be used, the new version cannot be used.</td>
</tr>
<tr>
<td>File exception in %s</td>
<td>Errors</td>
<td>A file error occurred when accessing a collective file.</td>
</tr>
<tr>
<td>Generic exception in %s</td>
<td>Errors</td>
<td>A general error occurred when accessing a collective file.</td>
</tr>
</tbody>
</table>